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Chapter 1

1: Welcome 

What is groov? 
groov is Opto 22’s web-based Internet of Things (IoT) and operator interface system that is simple, 
mobile, and connects easily to automation systems, software, databases, and devices of all kinds.

Simple: groov requires only a web browser to connect to devices and build mobile interfaces so you 
can monitor and control them. groov puts ready-made gadgets at your fingertips and requires no 
programming. Using tags from the built-in Data Simulator, you can test project ideas without 
connecting to a live machine or system. groov makes it simple to build, deploy, and view effective, 
scalable operator interfaces. 

Mobile: Get the free groov View app for Android or iOS to view your groov interface on your iPhone, 
iPad, or Android phone or tablet. Or use any brand device, from a smartphone to a web-enabled 
big-screen TV, and view your groov interface using a web browser. groov can augment existing 
human-machine interfaces (HMIs) and SCADA systems by making specific data available to 
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authorized users at any time and in any location. Using event notification, selected personnel can be 
alerted anywhere about system events based on one or more conditions.

Connects easily: You can connect groov to several data sources for monitoring and control in your 
mobile interface:

• Connect directly to Modbus/TCP devices and Opto 22 SNAP PAC controllers to access their 
data.

• Connect to PLCs and PACs from other manufacturers, such as Allen-Bradley ControlLogix and 
CompactLogix, Siemens SIMATIC S7, Schneider Electric Modicon, and GE PACSystems—and to 
any database or system supported by your server—through an OPC UA (Unified Architecture) 
server. 

• Use your database, a cloud service, or an API (application program interface) to place data in or 
read data from a groov Data Store, where you can access it for use in your mobile interface.

• (GROOV-AR1 groov Box only) Use Node-RED (included) to create logical flows for data you use 
in groov. Also connect to serial devices—Modbus RTU/ASCII, weigh scales, and more—via a 
USB-to-serial converter and Node-RED. 

groov brings key data from process control, OEM machines, manufacturing and building systems, 
and the Internet of Things (IoT) into the hands of those who need it. 

Connecting Data and Users
groov connects to a variety of data sources and presents that data to users for visualization and 
action. Your groov users may be human operators or software that uses the groov Data Store API. 

The image below shows how groov connects data sources and users. Automation data sources are 
on the left; they interact directly with groov. On the right are software users that write data to a groov 
Data Store or read data from that store, via the API. At the bottom are operators who interact with 
your groov interface; they can securely view and act on data from automation sources and the Data 
Stores, as you determine. You manage all users and control what each one can see and do. 
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groov Build
groov Build provides a library of pre-built gadgets for developing a graphical operator interface. It 
comes with the built-in ability to import and use tags from a variety of systems and equipment, 
including Modbus/TCP devices, Opto 22 SNAP PAC controllers, and many other manufacturers’ 
systems, equipment, and databases. You also use groov Build to manage user accounts and set up 
email or text message event notifications.

groov View
groov View runs your groov operator interface , which resides on a groov Box or groov Server and 
can be accessed on smartphones and tablets using the free groov View apps for iOS and Android. Or 
access it from a computer or other device with a web browser and a network connection to groov.

groov View on a tablet and a smartphone
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groov Build and groov View
The following chart compares Build and View.

Mobile Device Apps
groov View for iOS and groov View for Android are free native apps for your tablet or 
smartphone. You can run groov in your browser, but these apps display your interface in full-screen 
mode. 

groov Build groov View

What it’s for Building an operator interface:
• Connect to devices and systems
• Build screens
• Authorize users
• Back up projects

Viewing an operator interface:
• Monitor and control equipment/system

Who uses it Authorized groov Build users: 
• An Admin has full control
• An Editor can change pages but cannot 

authorize users

Authorized groov users: 
• An Operator can log in/out & change 

password
• Kiosk users cannot log out or change 

password

Password groov Build software password
• An Admin sets the username and password 

at first login to groov. 
• An Admin user can assign usernames and 

passwords to Editors and other Admins.

groov View password
A username and password are assigned 
to each user by a groov Build Admin.

How to get 
there

Use a web browser.
groov Box
For the URL, enter:
https://[hostname]/
Or: https://[IP address]/
groov Server
For the URL, enter:
https://localhost/
Or: https://[Server’s hostname 
or IP address]/ 

From groov, click Settings (gear in upper 
right), and choose Switch to groov Build

Use the free groov View app for iOS or 
Android. Open the app and log in with 
your username and password.

Or use a web browser. For the URL, 
enter:
https://[hostname]/

How to get 
there in groov 
Find (Windows 
PC only)

For a groov Box (does not apply to groov 
Server): Click Search for devices. 
Find the serial number of the groov Box. Click 
groov App.

[Not normally used]
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These native apps add other advantages as well. You can add another layer of security by setting up 
passcodes in the app. If you have more than one groov, you can easily access all of them from the 
app.

The iOS app is also ideal for OEMs and machine builders who want to use a tablet as an operator 
interface to a machine. You can lock the device so it runs only groov.

Get groov View for iOS. 
Get groov View for Android. 

groov Models
groov is available as either the standalone groov Box hardware appliance or the PC-based groov Server 
for Windows software.

groov Box (p/n GROOV-AR1-BASE) is an industrially hardened appliance that 
comes preloaded with groov software, including groov Build for building 
operator interfaces, groov View for using the interfaces you’ve built, and groov 
Admin for administering the Box itself. It also includes Node-RED, an 
open-source, multi-platform software tool for wiring together databases, 
cloud applications, and APIs to produce Internet of Things (IoT) applications 
quickly and inexpensively. Through Node-RED the groov Box can also use a 
USB-to-serial converter with FTDI chipset to connect to serial devices like 
weigh scales, Modbus RTU/ASCII devices, and more. The groov Box can 
communicate over a standard Ethernet network or wireless LAN (optional; 
requires third-party WiFi adapter), or both. 

groov Server for Windows (p/n GROOV-SVR-WIN-BASE) includes groov software (groov Build for 
building operator interfaces and groov View for using them) and is ready for installation on a 
Microsoft® Windows® PC. Once installed, groov Server runs as a service on your computer. 

Whether you serve groov software from a groov Box or a computer using groov Server for Windows, 
your groov operator interface can be viewed on almost any mobile device or computer. And you can 

View in browser View in app

https://itunes.apple.com/us/app/groov-view-for-ios/id639797810?mt=8
https://play.google.com/store/apps/details?id=com.opto22.aWD
http://www.opto22.com/site/pr_details.aspx?cid=4&item=GROOV-AR1-BASE
http://www.opto22.com/site/pr_details.aspx?cid=4&item=GROOV-SVR-WIN-BASE
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develop on one groov and later move your project to another: for example, develop on groov Server 
and then move the project to a groov Box. 

For more information on the groov Box, see the groov Box User’s Guide (form 2104). 
For groov Server, see the groov Server for Windows User’s Guide (form 2078).

Platform Options

Three groov platforms are available, so you can choose the right one for your application. Platform 
choice depends on how many Modbus/TCP-ready devices, Opto 22 SNAP PAC controllers, and Data 
Stores will be connected to groov, and whether an OPC UA server or OPC UA-compatible hardware 
device will be used. (The Data Simulator and groov System data are included with all platforms.)

The groov platforms are:

• groov Solo—Using either the groov Box (GROOV-AR1-BASE) or groov Server 
(GROOV-SVR-WIN-BASE), connect to one Modbus/TCP device, or one Opto 22 SNAP PAC 
controller, or one Data Store. groov Solo is ideal for machine builders and OEMs—who need 
only one controller or system connection—and offers a lower price for entry-level customers.

• groov Plus—Add GROOV-LIC-PLUS to your groov Solo Box or Server and connect to multiple 
Modbus/TCP devices, Opto 22 SNAP PAC controllers, and Data Stores. groov Plus is best for 
multi-machine, system, and software applications, or for monitoring and controlling widely 
dispersed assets.

• groov Enterprise—Add GROOV-LIC-ENT to your groov Solo Box or Server, or add 
GROOV-LIC-OPE to your groov Plus Box or Server, and connect to machines, PLCs, and other 
equipment and systems that support OPC UA, in addition to multiple Modbus/TCP devices, 
Opto 22 SNAP PAC controllers, and Data Stores.

Applications change, and if you need to connect more devices to groov, or add an OPC UA server or 
OPC UA-compatible equipment, you can quickly upgrade from one groov platform to the next.

System Requirements
For groov Box and groov Server for Windows

To build operator interfaces with groov you’ll need:
• Any computer with a web browser (does not have to be a Windows PC)
• One or more of the following:

– A Modbus/TCP device
– A database, online service, or software program to get data from or put data into a Data 

Store using the groov API
– An Opto 22 SNAP PAC controller (SNAP PAC S-series, R-series, or SoftPAC, with firmware 

R9.2a or newer), running a PAC Control strategy
– Any OPC UA-compatible automation system or equipment, plus an OPC UA server and 

drivers for your equipment

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4381
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– A database, cloud application, API, or serial device accessible via a Node-RED node (groov 
Box only. Serial device requires a USB-to-serial converter with FTDI chipset, groov Admin 
R1.570.46 or higher, and Node-RED for groov Box version 3 or higher)

groov and KEPServerEX: If you are building a groov interface for an OPC UA compatible system and 
don’t already have an OPC UA server installed, the KEPServerEX communication platform from 
Kepware Technologies is recommended by Opto 22 and tested to work with groov.
Kepware has developed hundreds of device drivers to communicate with automation systems, 
industrial databases, and other software. For more information: 
www.kepware.com/Products/products_OPCServers.asp. Also see: 
www.kepware.com/Support_Center/doc_auto_tag.asp

For groov Server for Windows

To install and run groov Server for Windows you’ll need:

• A PC on the same network as your control device, with one of the following Microsoft 
operating systems. If you're using an OPC UA server, it can be the same or a different computer.

– Windows® 10 Professional (32-bit or 64-bit) 

– Windows 8 Professional (32-bit or 64-bit) 

– Windows 7 Professional (32-bit or 64-bit)

– Windows Server® 2012

– Windows Server 2008 R2

NOTE: .NET Framework 3.5 or greater is required for all operating systems. Use the “Add roles and 
features” option for Windows Server 2012.

• A minimum of 250 MB available disk space to install groov Server for Windows. Additional disk 
space is required for the project you build. 

A Note on Browsers
Thanks to technologies such as HTML5, SVG, and CSS3, modern browsers are now fairly similar. Our 
browser-based groov View and groov Build work on a large number of device/operating 
system/browser combinations, including HDTVs, smartphones and tablets of many shapes and 
sizes, and computers. We’ve found Firefox, Chrome, Safari, and Internet Explorer 10 or newer to be 
generally reliable. If one browser is causing problems for you, however, try another one and let us 
know what issues you’ve seen. For Product Support, see page 8. 

About This Guide
This user’s guide teaches you how to build and view an operator interface with groov.

This guide assumes that you have already set up your groov Box or installed and set up groov Server 
for Windows, and that you are already familiar with your personal computer’s operating system and 
how to use your tablet or smartphone.

To set up a groov Box and get started with groov, see form 2103, the groov Quick Start for 
GROOV-AR1. Also see form 2104, the groov Box User’s Guide for GROOV-AR1.

http://www.kepware.com/Products/products_OPCServers.asp
http://www.kepware.com/Support_Center/doc_auto_tag.asp
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4448
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
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To install and get started with groov Server for Windows, see form 2078, the groov Server for 
Windows User’s Guide.

In this guide 
Chapter 1: Welcome introduces this user’s guide and groov.

Chapter 2: Building a Project walks you through building a sample project, and then describes 
how to create pages, add devices and tags, and configure gadgets.

Chapter 3: Managing groov describes how to manage user accounts, back up and restore your 
project, and update groov and your license.

Chapter 4: Gadget Reference provides details on how to configure gadget properties.

Chapter 5: Using Events and Notifications describes how to set up user accounts and event 
conditions in groov so that users can be notified about system status.

Chapter 6: Viewing Your Operator Interface describes how to open and use a groov HMI on any 
device with access to the Internet.

Chapter 7: Troubleshooting and Additional Help provides troubleshooting information and 
answers questions you may have about groov.

Appendix A: IP Cameras describes the IP cameras that work with the Video gadget.

Appendix B: OPC UA Data Types Supported lists the OPC UA data types supported in groov and 
the corresponding groov names. 

Appendix C: Data Simulator Tags lists the Data Simulator tags and briefly describes what they do.

Other groov Resources
Resources for groov are on www.groov.com. Additional resources for groov and other related 
products—such as PAC Project—are also available on the Opto 22 website, www.opto22.com.

Product Support
If you have any questions about groov, you can call, fax, or e-mail Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 
toll-free in the U.S. and Canada)
951-695-3080
Monday through Friday, 
7 a.m. to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: www.opto22.com

NOTE: Email messages and phone 
calls to Opto 22 Product Support 
are grouped together and 
answered in the order received.

http://groov.com/
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4381
http://www.opto22.com/
mailto:support@opto22.com
http://www.opto22.com
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When calling for technical support, be prepared to provide the following information about your 
system to the Product Support engineer:

• groov type (groov Box or Server) and platform

• groov version. In Build, select Help > About.

• A description of your system equipment:

– Computer type, speed, memory, and operating system

– Brand and model numbers for the controllers or devices you are monitoring and 
controlling through groov

• A description of the network

• Specific error messages or other diagnostic indications
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Chapter 2

2: Building a Project

This chapter describes the basic aspects of creating an operator interface in groov Build, including 
how to create pages, add devices and tags, and configure gadgets. The operator interface you build 
resides on the groov Box or on the PC where groov Server is installed, and it can be accessed from a 
computer, smartphone, tablet, or other mobile device with a web browser.

In this chapter:
Opening Build in groov Server for Windows...................... 11
Opening Build on a groov Box.................................................. 12
Building a Sample Project........................................................... 13
Working with Pages....................................................................... 21
Adding a Device.............................................................................. 28
Adding Gadgets .............................................................................. 57
Editing Gadgets............................................................................... 59
Optimizing Layouts........................................................................ 63

Opening Build in groov Server for Windows
The first time you open groov, make sure to follow the instructions in form 2078, the groov Server for 
Windows User’s Guide.
1. Open Firefox, Chrome, or Internet Explorer 10 or newer and do one of the following:

– If groov Server is installed on the same computer, type https://localhost in the 
address bar of your browser.

– If groov Server is installed on a different computer, type https:// and the computer’s 
hostname. For example, if the computer’s hostname is RStarr-w7, you type 
https://RStarr-w7

You can use the IP address of the host PC instead of the hostname. However, if the PC is on 
a network with DNS and DHCP, the IP address is subject to change.

NOTE: If groov does not open, see Chapter 7: Troubleshooting and Additional Help

2. When groov opens, log in. 

groov opens first in groov View.

Address bar

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4381
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3. Click the gear icon on the top right-hand side and click Switch to groov Build.

Opening Build on a groov Box
The first time you open groov, make sure to follow the instructions in form 2103, the groov Quick 
Start for GROOV AR1. For additional information, see form 2104, the groov Box User’s Guide for 
GROOV AR1.

NOTE: In order to use a URL hostname, your network must have a DNS. If it doesn’t, see page 148 for 
information on how to use groov Find.

1. Enter https:// and your groov Box’s hostname as the URL. The hostname is printed on the 
bottom of the groov Box. 

For example, if the hostname is opto-00-d2-dc, you type: 
https://opto-00-d2-dc

NOTE: If you’ve assigned a static IP address to the groov Box, use the IP address instead of the 
hostname to open groov.

2. When groov opens, enter your username and password. 

groov opens first in groov View. 

3. Click the gear icon on the top right-hand side and click Switch to groov Build.

Gear icon

Hostname

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4448
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
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Building a Sample Project
To get started, let’s build a page using tags in the Data Simulator and then view it on the computer. 
Here’s what we’ll do:

• Add a page 

• Add device tags (page 14)

• Add gadgets (page 15)

• Save the project (page 17)

• View the project on your computer (page 17)

• Explore (page 18)

When groov Build opens, you see the workspace where you’ll build your operator interface:

Add a Page
1. In the Pages panel on the left side of the workspace, click Add Page. 

List of all pages in 
your interface. 

Page you’re working 
on appears here.

Add pages and 
organize them into 
categories.

See properties for the 
page highlighted in 
the list. 

Page as viewed on computer or tablet Page as viewed on smartphone
Choose gadgets and tags.

Assign gadget properties.
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2. Give the page a name and click the color block to choose a background color. For now, leave 
the page as Uncategorized and leave Access Rights as All Users. Click OK.

The blank page appears in the center of the workspace.

Add Device Tags
1. In the Gadget Palette panel (lower right), click Configure Devices & Tags.

2. Click Add New Device and then choose Data Simulator.

The Data Simulator appears in the device list.
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3. Click Close, and notice that Data Simulator now appears in the Gadget Palette. Click the plus 
sign next to Data Simulator and other plus signs in the tree to see the tags in the device.

Add Gadgets
1. Expand the tree to find bool Variable A. Click this tag.

A list appears showing all the gadgets that work with this tag. 

2. Click the LED gadget and drag it to the page you’re building. 
3. Click the gadget to highlight it and notice that properties appear in the Gadget Properties 

panel (upper right). 
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4. Scroll down to see all the possible properties you can choose and adjust. Enter the following 
properties and watch how the LED gadget changes after each one.

5. Notice that part of the LED and its label text are hidden. Use your mouse to grab a corner 
handle on the gadget and pull it out so everything is visible. 

Property You choose... Result

Label Line 21 Tag name is replaced with label.

Alignment Right Label moves to right of gadget.

Text Size

12 Label text becomes smaller (default is 16 pixels).

Click 

Button changes to show link broken. This means that the 
label text size you just chose (12) will affect only the Desk-
top & Tablet view, not the Handheld view. 

Font Verdana Font on the label text changes.

Text Styling B Label text is boldfaced (thicker).

Colors
Text: Deep Green Text changes color.

Background: Pale Green Light green background appears in gadget area.

Graphic Size Uncheck Auto and 
choose 6 LED becomes larger.

On/Off Colors
True: Dark Green LED color changes.

False: [Leave as is] No change
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6. In the Gadget Palette, click bool Variable A again. Click Button and drag it to the page, next to 
the LED. Click to highlight it. In the Gadget Properties area, enter the following: 

7. With the button highlighted, adjust its handles so it’s about as large as the LED gadget. Make 
sure you can see all the text. 

Your page now looks something like this:

Save the Project
From the File menu, choose Save All Changes and Switch to groov View. 

View the Project on your Computer
Your saved project opens in groov View. 

Property You choose... Result

Confirm Writes Check the box When someone pushes this button, they’ll be required 
to verify the button’s action before it happens.

Display Mode [Leave as Button] No change

Label Turn ON/OFF Button text changes.

Text Size 12 Text becomes smaller.

Font Verdana Text font changes.

Text Styling B Text is boldfaced.

Colors

On indicator: Green LED embedded in the button changes color.

Off indicator: [As is (black)] No change.

Text: Deep Green Text color changes slightly.

Button: White Button color changes.
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Try it out! Click the button and see what happens. 

Explore

1. Go back to groov Build by clicking the gear icon in the upper-right corner of the window  

and choosing Switch to groov Build. 
2. Click the Handheld tab, just above your page in the center of the workspace.

While you were building your page in the Desktop & Tablet tab, groov automatically put the 
same gadgets in the Handheld tab, which shows the page layout for a smartphone. However, 
you may want the page to look different on a phone. Maybe some data or controls are more 
important and should be at the top of the page. Or maybe some don’t need to be on the 
phone at all. In this tab you can resize, rearrange, change, or delete gadgets to suit your needs.

3. Click to highlight each gadget and change its size and position the way you want. 

Remember that you made the text size smaller (12 instead of 16) for both the LED and the 
button? You also broke the link between the two views for that property, which means you 
changed it for one view only. So the text is smaller for Desktop & Tablet, but for Handheld it 
remains at the default of 16. 

You can make the two views different in other ways as well. For example, suppose you want 
smartphone users to be able to see the status of Line 21 but not be able to turn it on or off. You 
can stash the Turn ON/OFF button so it’s not visible in the Handheld view.

4. In the Handheld tab, notice the area off to the right of the page with a dotted line around it. 
Drag the Turn ON/OFF button into this area, which is called the page stash.
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The button will still be shown on a computer or tablet but will not be visible on a smartphone. 
You can also stash gadgets in the Desktop & Tablet tab if you don’t want them to appear on 
these devices, so you can customize the view on large and small devices. 

Now let’s explore some more. 

Images

When we added the Turn ON/OFF button, one of the properties was Display Mode. Let’s take 
another look at that now.
1. In the Desktop & Tablet tab, select the Turn ON/OFF button and look in the Properties panel.
2. For Display Mode, choose Image. 

As you can see, instead of a simple button, you could skin the button with images: one image 
indicates that the button is On and the other that it is Off. 

3. Click a broken image to open the Image Library, where you can add images to your project. 

All the images for your groov project are stored in the Library. You can add and delete images. 
You can use the same image in multiple places, and if you change it, it’s automatically updated 
everywhere it’s used. Compatible file types for images are BMP, GIF, PNG, JPG, and SVG. For 
more on the Image Library, see page 72. 

Here’s what the Image Library looks like before you’ve added any images:

Page stash

Click to open the Image Library and 
choose or add the On Image.
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4. For now, click Cancel to exit the Image Library. In the Properties panel, change Display Mode 
back to Button.

Round Gauge
Let’s look at a gauge.
1. In the Gadget Palette, expand the tag tree again. Under Basic > Variables, choose 

float32 Variable A. In the gadget list, click Round Gauge and drag it to your page. 
2. Highlight the new gadget and look at its properties.To understand all the options, see “Round 

Gauge Gadget” on page 106. But for now, change only the following: 

3. Scroll down to Color Ranges and click Add Range.

4. Click the blue rectangle and choose Red. Enter Min Value 0 and Max Value 20.

Property You choose... Result

Range Min value 0, Max value 100 The gauge changes to show 0-100.

Units Gallons “Gallons” appears below the numeric value on the 
gauge.

Precision 0 Value will be shown in whole numbers (no digits after 
the decimal point).

Colors Needle: Black
Background: Dark Orange Colors change on the gauge.

Change how your images 
are shown in the lbrary.

After you add them, your 
images appear here.

Click to choose the color for this range.
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5. Click Add Range again. For Color, choose Orange. Enter Min Value 20 and Max Value 40.
6. Click Add Range again. For Color, choose Dark Green. Enter Min Value 40 and Max Value 100.

Your gauge now looks like this:

What’s Next?
Now that you have an idea of what groov can do, you can get to work on your real project. 

To connect to your systems and equipment, see these sections:

• “Adding a Modbus/TCP Device” on page 32

• “Adding an Opto 22 PAC Controller” on page 30

• “Adding an OPC UA Server” on page 43

For help on choosing gadget properties, see Chapter 4: Gadget Reference on page 89.

To set up users and passwords and control who accesses your groov interface, see “Managing User 
Access” on page 65.

To notify authorized people when events occur, see Chapter 5: Using Events and Notifications on 
page 115.

Working with Pages
Your operator interface can consist of one or many pages, depending on your application’s needs. 
You may have separate pages for different functions, different people, or different locations. You use 
the Page Navigator gadget to provide a link so users can go from one page to another. 

Adding Pages
1. In groov Build, click Add Page in the Pages panel on the left side.

This gauge is easy for an operator to understand at a glance. 
Anything in the green range is OK, but if the needle dips down 
into the red, you have a problem. 

The numeric value appears in blue at the bottom of the gauge. 
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2. Type a name for the page.
3. If you wish, choose any of the following options:

– Click the Background Color square to choose a color for your page. 

– If you have added page categories (see page 76), select a category for this page. 

– Limit access rights based on user security level (see “Creating a User” on page 66). Or, if you 
want only specific users to see this page, choose Limited Access. If the page is Limited 
Access and you have already added user groups (see page 65), select the groups that 
should see this page. 

4. Click OK.

Your new page appears in the middle of the workspace. 

Changing Page Properties
You can change an existing page’s name, permissions, or other properties.

NOTE: When you import a page, any permissions limitations it may have had are not imported. If you want 
the page to be limited, you must change its permissions after importing.
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1. In the Pages panel on the left side of the workspace, click the 
page you want to change. 

In the Page Properties panel just below, you see the current 
page properties. (Both panels are shown at right).

2. Change Name or background color as needed.
3. To hide the page so no users can see it, click Hidden (useful 

when you are building a new page).
4. To change user permissions for the page, click Edit Page 

Permissions. 

You can limit access rights based on user security level (see “Creating a User” on page 66). Or, if 
you want only specific users to see this page, choose Limited Access. If the page is Limited 
Access and you have already added user groups (see page 65), select the groups that should 
see this page.

5. Click OK.

Page Size and Grid
As you fill your page with gadgets, you may find you need more room. Click the Increase Height 
button at the bottom of the work area. If you switch to another page and then return, the page will 
shrink to fit the content or return to the default page size, whichever is larger.

When you place or move gadgets on the page, they automatically snap to a grid so they are aligned. 
If you want to see the grid, at the bottom of the work area click “Show grid.” 
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Using the Page Stash
The workspace for each page has a page stash where you can put gadgets that are not yet part of 
the project. Or if you don’t want a gadget to appear in the Handheld layout, for example, you can 
move it to the page stash; the gadget will still appear in the Desktop & Tablet layout. 

To see the page stash in the Desktop & Tablet view, select “Zoom out to show page stash” at the 
bottom of the work area. In the Handheld view, the page stash is always visible to the right.

Viewable area with 
grid turned on

Click to make page longer.
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Deleting a Page
1. In the Pages panel at left, hover over the page or category name, and then click the red X that 

appears.

2. To verify, click OK.

Page stash

Click the red X.
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Renaming a Page
1. In the Pages panel, right-click the page name and select Rename.

2. Enter a new label, and press Enter or left-click in the work area.

Duplicating a Page
1. In the Pages panel, right-click the name and select Duplicate.

A copy appears in the same page category.

2. Right-click the copy and select Rename to give the page a new name.
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3. If you want, you can drag it to a new position in the list or to a different page category.

Exporting and Importing Pages
You can move pages from one groov project to another by exporting and importing them. When 
you export, only the page layout with gadgets is exported. Associated tags, images, and page 
navigators are not exported. In addition, if you limited viewing permissions to specific user groups, 
those limitations are not exported. 

The export file is downloaded to your PC with a date and time stamp as its filename. 

Export a page

1. In groov Build, choose File > Export Page. 

The file is immediately downloaded. The filename looks something like this: 
Groov_Page_D04242017.T211956.json

2. Save the file with a filename you’ll recognize in the location you want. Make sure you retain the 
.json file extension.

Import a page 

1. Open the groov project you want to import the page to.
2. Choose File > Import Page.



ADDING A DEVICE

groov Build and View User’s Guide28

a. Click Browse and find the file you exported. 
b. In the Page Name field, enter the name for the page in this project. 
c. (Optional) Choose a category for the new page.

3. Click Import.

A new page is created in the project, containing the gadgets and layout from the imported 
page.

4. Complete the new page by:

– Adding tags for each gadget

– Replacing any images

– Adding page navigators appropriate for this project

– Editing page permissions
5. Save the page.

Adding a Device
Any device, system, or software you want to monitor, control, or exchange data with—including 
groov itself—must be added to groov as a device. When you add the device you also add its tags, so 
that you can tag the groov gadgets to make them operational. 

If you have groov Solo, you can add one SNAP PAC controller or one Modbus/TCP device or one Data 
Store. If you have groov Plus or Enterprise, you can add as many PACs, Modbus devices, and Data 
Stores as you like. To add an OPC UA Server, you must have groov Enterprise. 

With all groov platforms, you can also add the Data Simulator and groov System tags.

NOTE: Devices cannot talk with each other directly. For example, a Modbus/TCP device cannot write data 
to a Data Store; a SNAP PAC controller cannot read groov System data. However, you can use Node-RED in 
the groov Box (or on your PC) to create a logical flow that exchanges data between devices that have 
Node-RED nodes. For more on Node-RED, see nodered.org and the groov Box User’s Guide for GROOV-AR1 
(form 2104). 

This section includes:

“Adding Data Simulator Tags,” page 29

“Adding an Opto 22 PAC Controller,” page 30

“Adding a Modbus/TCP Device,” page 32

“Adding an OPC UA Server,” page 43

“Adding a Data Store” on page 54

“Adding System Tags,” page 51

“Editing a Device’s Address,” page 56

“Deleting a Device,” page 57

https://nodered.org/
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
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Adding Data Simulator Tags
A Data Simulator is built into groov that provides simulated dynamic values for onscreen gadgets; for 
instance, a Graph gadget can use a simulator tag that provides changing values for a sine wave, or a 
gauge can use a simulator tag with an integer moving between high and low values. These 
simulator tags allow you to experiment with adding tags to gadgets, configuring the tags, and 
running your project in groov View. For descriptions of the tags available in the Data Simulator, see  
“Appendix C: Data Simulator Tags.”

Follow these steps to add a Data Simulator tag. 
1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags, or select 

Configure > Devices and Tags.

2. Click Add New Device and then select Data Simulator.

The Data Simulator appears in the device list.
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3. Click Close, and notice that Data Simulator tags are added in the Gadget Palette. Click the plus 
signs to expand the tree and see the tags.

Adding an Opto 22 PAC Controller
Follow these steps to add an Opto 22 controller that the operator interface will communicate with. 
When you add a controller and the .idb.txt file associated with the strategy that runs on the 
controller, the strategy’s tags become available in groov for you to use. Repeat the steps to add 
additional Opto 22 controllers and tags.
1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags, or select 

Configure > Devices and Tags.
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2. Click Add New Device and then select Opto 22 Controller.

3. Enter the hostname or IP address of the controller running the strategy you want to use.

For a SoftPAC controller, use the full name of the computer running SoftPAC as in this example: 

JAlvarez-w7.ACME.com

4. Click Browse to locate the .idb.txt file you want to use.

NOTE: When PAC Control compiles a strategy it automatically generates an .idb.txt file and places it in 
the same directory as the strategy. If you are setting up groov on a computer other than the one used 
to develop the PAC Control strategy, copy the .idb.txt file into a directory that is accessible to the 
computer you are using to set up groov.

5. Click Import, and then click Close.

Build imports the .idb.txt file. In the Gadget Palette, you see the name of your strategy and the 
IP address of your SNAP PAC controller. Click the plus signs to expand the tree and see all the 
tags.
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Updating a Strategy

If a controller’s strategy has been changed, you need to update it in groov by importing its new 
.idb.txt file.
1. Select Configure > Devices and Tags.
2. Highlight the controller you want to update, and then click Update Strategy.

CAUTION: Be very sure you are updating the correct strategy. If you use the wrong one, all of the 
controller tag connections will break. This is critical because re-importing the correct strategy will not 
fix the broken gadgets. You can only fix the connections by restoring your project with a recent 
backup.

3. Browse to the strategy you want to use, select the new .idb.txt file, and then click Open.

NOTE: The .idb.txt file is in the same directory as the strategy. If groov is on a different computer than 
the strategy, copy the .idb.txt file into a directory accessible to the computer you are using for groov.

4. Close the Configure Devices and Tags dialog box.

Adding a Modbus/TCP Device
Modbus is an open protocol widely used in automation and other industries. Although it was 
originally designed for a serial network, Modbus has since been adapted to work over Ethernet as 
well. Over Ethernet the protocol is called Modbus/TCP. groov has a communication driver that 
allows groov to act as a Modbus/TCP master and communicate with Modbus/TCP slave devices that 
have an Ethernet connection. Note that groov does not support communication with serial devices 
via a Modbus serial-to-TCP gateway, due to high latency in serial networks.

TIP: Additional help is provided in groov. When a help button  is available, click the button for 
information directly related to that part of groov.

Follow these steps to add tags for a Modbus/TCP slave device for use in the operator interface.
1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags, or select 

Configure > Devices and Tags.
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2. Click Add New Device and then select Modbus Device.

3. In the Device tab, enter the following details:

Name: Enter a name to identify this Modbus device.

IP Address: Enter the Modbus device’s IP address or hostname. A hostname will be converted 
to an IP address by the DNS server.

Your device may have a static IP address, which you can find in the device’s documentation. 
The device may also come with software that allows you to set its IP address or view the 
address assigned to it by a DHCP server.

Slave ID: The Slave ID is typically used to address individual devices or memory segments 
located at a single IP address.

Check your device’s documentation to determine whether the slave ID is required for any 
reason. If it is not, leave this box empty.

Port: If left blank, port 502 will be used.

Port 502 is the standard Modbus port. Some Modbus devices may use a different port. Refer to 
your device’s documentation to determine which port number it uses.
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4. Click the Access Config tab and configure the following settings as necessary.

Modbus Protocol Settings
Be sure to check the documentation that came with your Modbus device for additional 
information about these settings. For more information about Modbus function codes, see 
www.modbus.org/docs/Modbus_Application_Protocol_V1_1b.pdf. 

– Use base-one addressing
If your device documentation specifies zero-based addressing or you simply prefer 
zero-based addressing, you can deselect this option to make tag addressing easier.

– Use function code 06 when writing a single register
If your device does not support Modbus function code 06 (0x06, Write Single Register), 
deselect this option. If it is deselected, groov will use function code 16 (0x10 Write Multiple 
Registers) for single-register writes.
If this option is checked in groov and your device does not support function code 06, you 
may receive errors. The error occurs with writes to any tag having a data type sized 16 bits 
or smaller.

– Use function code 05 when writing a single coil:
If your device does not support Modbus function code 05 (0x05, Write Single Coil), 
deselect this option. If it is deselected, groov will use function code 15 (0x0F, Write Multiple 
Coils) for single coil writes.
If this option is checked in groov and your device does not support function code 05, you 
may receive errors. 

– Do not use function code 22 when writing a single register bit:
If your device supports Modbus function code 22 (0x16, Mask Write Register), you can 
deselect this option to optimize writes. (Using function code 22 makes writes faster and 
ensures that the write operation is atomic.) 
If this option is checked, groov will use other functions to first read the whole register, 
modify the bit, and then write to the whole register. Note: Keep this option checked for an 
Opto 22 SNAP PAC controller or brain. 

Data Interpretation Settings

The Modbus protocol does not specify memory mapping. As a result, devices that store 
multi-register data types store the data differently. Use these settings to set the byte order of 
the data coming from your Modbus device for data types that span more than one 16-bit 

http://www.modbus.org/docs/Modbus_Application_Protocol_V1_1b.pdf
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register/address. See your device’s documentation to determine whether either of these 
settings needs to be changed. The device’s manual may use terms like high or low order or 
registers, or MSB (Most Significant Bit) or LSB (Least Significant Bit).

NOTE: Setting either of these settings incorrectly may result in garbage values for the affected data 
types. If you receive data that makes no sense, try changing these settings.

– Lower register contains the least significant part of 32-bit values: For 32-bit data types that 
span two 16-bit registers, this indicates that the first register read contains the least 
significant byte (LSB). 

– Low 32-bit value contains the least significant part of 64-bit values: For 64-bit data types that 
span four 16-bit registers, this indicates that the LSB is contained within one of the first two 
registers read. 

Example: Assume register values are:

– register 1 = A
– register 2 = B
– register 3 = C
– register 4 = D

Here’s how data will appear based on your settings:

5. When finished, click Add Device.

The Modbus device appears in the list of configured devices. Now you’ll add tags, either 
manually (below) or by importing them from a file (page 42).

Adding Modbus Tags Manually in groov

Use the steps below to manually add Modbus tags in groov Build. You can also add Modbus tags by 
importing them from a file. See “Importing Modbus Tags from a CSV File” on page 42.
1. Under Gadget Palette on the right side, click Configure Devices & Tags, or select 

Configure > Devices and Tags.

Settings Results

“Lower 
register”

“Low 32-bit 
value”

32-bit value 
from registers 1 & 2

64-bit value 
from registers 1-4

Not checked Not checked AB ABCD

Checked Not checked BA BADC

Not checked Checked AB CDAB

Checked Checked BA DCBA
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2. Highlight the Modbus device and click Configure Tags.

3. Click the Add button .

4. Enter the following attributes.

Tag Name: (Required) Give the tag a descriptive name.
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Data Type: (Required) Select the tag’s data type. If your Modbus/TCP device’s registers contain 
multiple status or command bits or bit fields in a single register, choose Boolean to access 
individual bits. 

Tag Address: (Required) The Tag Address Builder helps you construct valid tag addresses. After 
you see what a valid tag address looks like, you can enter the addresses manually in the text 
box in order to save time. Available options depend on the data type.

– Address Type: Identifies which memory segment will be accessed. Discrete Inputs and 
Coils are single-bit registers that represent Boolean values only. Input and Holding 
Registers are 16-bit registers that can be used for any data type.
Data types larger than 16 bits are mapped onto consecutive registers, starting at the 
register located at Start Address. Coils and Holding Registers are default Read/Write, while 
Discrete Input and Input Registers are Read Only.
To access individual bits in a register, choose Input Registers (Read Only) or Holding 
Registers (Read/Write).

– Start Address: Specifies where the tag value starts in memory. Strings may span multiple 
registers. Data types larger than 16 bits always span multiple registers.
To configure 0- or 1-based addressing, click Edit Device on the previous dialog box 
(Configure Devices and Tags) and then click the Access Config tab.

– String Length: Determines how many registers will be accessed to read or write the full 
string.
Strings are composed of ASCII characters (1 byte), so a single register may hold up to 2 
characters.

– Byte Order: Specifies how the characters are ordered within each register. H–>L indicates 
that the first character, when read left to right, starts at the most significant bit (MSB) and 
the last character ends at the least significant bit (LSB). If you are unsure about order, you 
can play with this setting to determine which one works.

– Bit Index: Identifies the bit within a register to be accessed. Valid bit values are 0–15.

– Array Size: To access multiple (contiguous) values of this Data Type using the same tag, set 
this size to 2 or more (up to a maximum of 65535, depending on the Data Type).
For example, if you want to access 10 contiguous floats that start with the specified Tag 
Address, set Array Size to 10.
String arrays are not supported.
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Access: (Optional) The options available depend on the data type. If you omit this value, the tag will 
assume the register type default setting.

Scaler: (Optional) Use the Scaler if a read/incoming value spans a much larger data range than you 
require, or to convert from one unit of measure to another. If you use this option, you must provide 
all components.

A Scaler
None: The raw input value is not modified in any way.
Linear Scaler: The raw input value is mapped linearly from the specified input range to the 
specified output range and data type. To flip the sign of the result (negative to positive or 
positive to negative), select “Negate the result” (D).
Here is the function used to scale the input:
Output = (((Scaled High - Scaled Low) / (Raw High - Raw Low)) * (Raw 
Value - Raw Low)) + Scaled Low

Square Root Scaler: The raw input value is mapped from the specified input range to the 
specified output range and data type using the following function:
Output = (√ ((Raw Value - Raw Low) / (Raw High - Raw Low)) * (Scaled 
High - Scaled Low)) + Scaled Low

B Raw Input Limits
High/Low: The High and Low Raw Input Limits must be within the range of values that the 
tag data type can store. 

C Scaled Result
Data Type: Select an available data type. Not all Modbus data types are valid output types 
for scaled values, so some data types are not listed.
Limit High and Limit Low: These values must be within the range of values that the scaled 
output data type can store.

D Negate the result: Select this option to flip the sign of the result (negative to positive or 
positive to negative).

Creating a Valid Modbus Tags Import File (CSV)
See also “Exporting a Modbus Tags Import File (CSV)” on page 41. 

A valid Modbus CSV file contains one tag per line and has this form: 
Tag Name, Data type, Tag address [, [Read/Write setting] [, Value scaler 
name, Scaled output data type, Input limit low, Input limit high, Output 
limit low, Output limit high, Negate]]

A

B C

D



CHAPTER 2: BUILDING A PROJECT

groov Build and View User’s Guide 3939

When viewed in a text editor, a CSV file containing Modbus tags might look like this:

Here is the same file viewed in Microsoft Excel:

Tag Name: (Required) Give the tag a descriptive name.

Data Type: (Required) 

Tag Address: (Required) Use a basic 6-digit address (exception: if you access individual bits within a 
register, the address includes 6 digits plus a point and the bit number, for example: 302000.12). 
The first digit defines the register type:

0 = Coil

1 = Discrete Input

3 = Input Register

4 = Holding Register

The next five digits are the start address:

• For devices with a base 0 addressing, the start address range is 0–65535.

• For devices with a base 1 addressing, the start address range is 1–65536.

NOTE: The start address is decimal by default but may be expressed in hexadecimal format. For hex:
- Place an “H“ or “h“ character in front of the entire address (for example, H30009F). 
- Follow the H with the address type byte plus a 0 (zero).
- Then show the hex address using 4 hex bytes. The most significant digit will always be 0.
Examples: 000001, 400203, H10FFFF

Registers 0 (Coils) and 1 (Discrete Input) are single bit registers and may be used for Boolean data 
types only. All other data types must use one of the 16-bit register types (3 or 4).

Tag Name Data Type Tag Address Access

Scaler

Tag Name Data Type Tag Address Access

Scaler
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There are limits on the tag start address. The following formula is used to determine if the tag 
address is within bounds of the registers:

OK if: 65536 <= Start Address + (ArraySize * Data Type Byte Size) / 2

For the String data type: Use the basic address followed by a “ . “ and then a decimal number in the 
range 2–240 to designate the number of characters in the string. Use either an “L“ or “H“ to 
designate character ordering within the registers. Only ASCII characters are supported (1 byte each); 
therefore each 16-bit register can contain up to 2 characters. “L“ indicates a Low-to-High byte 
ordering (the first character contains the LSB) and “H“ indicates the opposite.

Examples: 300001.20H, H4000F9.120L

For all other data types: Data types other than strings may be represented as arrays using a basic 
address followed by a space, an opening bracket “[“, a positive integer value in the range 2–65536, 
and a closing bracket “]“. 

Examples: 100003 [50], 300045 [20])

The array starts at the start address and extends through the designated number of elements. The 
start address + array size may not exceed 65536 registers. The size of the data type must also be 
factored in, as many data types span multiple registers.

Access: (Optional) This setting must match one of the options available for this data type in groov 
Build (for example, Read/Write, Read Only). It is not case sensitive. If this value is omitted, the tag will 
assume the register type default setting. If a value scaler is set, the Read/Write setting must be 
provided or an empty place reserved for it with commas (Tag address, ,Value scaler).

Scaler: (Optional) If this option is used, all components must be provided.

A Scaler Name: The scaler name must be None, Linear, or Square Root. The name is not case 
sensitive. The Scaler allows you to modify and control raw data values. This may be 
necessary if for example a raw value spans a much larger data range than you require. Or 
perhaps you need to digitize an analog value that comes in as a floating point number. 
There are many reasons why a scaled value may be useful or necessary. Below are the 
available scaling functions.
None: The raw input value is not modified in any way.
Linear: The raw input value is mapped linearly from the specified input range to the 
specified output range and data type. Selecting “Negate the result” causes the sign of the 
result to be flipped (negative to positive or positive to negative). Below is the function used 
to scale the input:

B C

...Linear,16-bit Signed Integer,-3.4028235E38,3.4028235E38,-32768,32767,false

A D E

Scaler
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Output = (((Scaled High - Scaled Low) / (Raw High - Raw Low)) * (Raw 
Value - Raw Low)) + Scaled Low

Square Root: The raw input value is mapped from the specified input range to the specified 
output range and data type using the function below:
Output = (√ ((Raw Value - Raw Low) / (Raw High - Raw Low)) * (Scaled 
High - Scaled Low)) + Scaled Low

B Data Type: The scaled result data type must match one of those offered in the UI. Not all 
Modbus data types are valid output types for scaled values so check groov Build to see the 
current list of types.

C Raw Input Limits: The Low and High Raw Input Limits must be within the range of values 
that the tag data type can store.

D Limit Low and Limit High: Must be within the range of values that the scaled output data 
type can store.

E Negate the result: True or False. Causes the sign of the result to be flipped (negative to 
positive or positive to negative).

Exporting a Modbus Tags Import File (CSV)
If you already have tags attached to the device, you can export a CSV file containing all of the device 
tags. Exporting some pre-configured tags is the fastest way to see what a valid tag CSV file looks like. 
1. Under Gadget Palette on the right side, click Configure Devices & Tags, or select 

Configure > Devices and Tags.

2. Highlight the Modbus device and click Configure Tags.
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3. Click Export to send the CSV file to the default downloads directory. Or, right-click Export and 
select “Save link as” to choose the target directory, and then click Save.

A CSV file with the Modbus device tags is created and downloaded to the default or designated 
directory.

Importing Modbus Tags from a CSV File

If you have a comma-separated values (CSV) file in the proper format with Modbus tags you want to 
use, you can import the tags directly into groov. See also, “Creating a Valid Modbus Tags Import File 
(CSV)” on page 38)
1. Under Gadget Palette on the right side, click Configure Devices & Tags, or select 

Configure > Devices and Tags.

2. Highlight the Modbus device and click Configure Tags.
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3. Click Import.

4. Browse to a valid comma-separated values (CSV) file that has a .csv extension, then click Open.

A Tag Import Report appears.

5. Click Close. The tags appear in groov.

Adding an OPC UA Server
Equipment that is neither a Modbus/TCP device nor manufactured by Opto 22 can still be 
monitored and controlled in groov if you have an OPC UA server or if it is an OPC UA-compatible 
hardware device. If you need an OPC UA server, the KEPServerEX communication platform is 
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recommended by Opto 22 and tested to work with groov. For more information, go to 
www.kepware.com/Products/products_OPCServers.asp. 
Also see www.kepware.com/Support_Center/doc_auto_tag.asp

Follow these steps to add an OPC UA-compliant server or equipment to groov.
1. In the Gadget Palette in the lower-right corner of groov Build, click the Tags tab, and then click 

Configure Devices & Tags. Or select Configure > Devices and Tags from the menu bar.

2. Click Add New Device and then select OPC UA Server.

3. Enter the Name of the OPC UA server.

4. For the Server URL, using the following format, enter the IP address or hostname of the 
computer where the OPC UA server is installed, and enter the port (for Kepware the default is 
49320). You can also enter the path of the OPC server endpoint.

Check your server for what these values should be.

Example server URLs

10.20.30.40:49320

10.20.30.40:49320/Path

MyServer:49320

MyServer:49320/Custom/Path

MyServer.MyDomain.com:49320

MyServer.MyDomain.com:49320/Path

MyComputer.MyCompany.com:49320/path

Computer hostname Port

http://www.kepware.com/Products/products_OPCServers.asp
http://www.kepware.com/Support_Center/doc_auto_tag.asp
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Default ports 
Different OPC UA servers use different ports. Here are the default ports for some servers:

KEPServerEX: 49320

TOP Server: 49380

Ignition Gateway: 4096

MatrikonOPC UA Wrapper: 21381

MatrikonOPC Universal Connectivity Server: 4846

5. Click Add Server.

Using Static Tags
When you add an OPC UA Server, groov accesses the controller’s static tags and makes them 
available so that you can directly browse the tags on the server. groov keeps the server’s tag 
hierarchy and displays the tags in a tree format. As long as you are connected to the server you can 
browse to find the tag you need in the Gadget Palette or by clicking dynamic link next to “Tag” on a 
gadget’s properties panel. The tags load automatically as you expand the tree.

Updating Static Tags
If you know that static tags have changed, or if a link to a tag is broken, you can update the static 
tags on an OPC UA server. When you update the static tags, groov displays a report that lists any 
deleted or modified tags so that you can choose different tags as necessary.

To update static tags, select a OPC UA server in the Configure Devices and Tags dialog, and then click 
Update Static Tags.

Expand a server’s tag tree 
to load its static tags
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Any deleted or modified tags will be listed in the Update Static OPC UA Tags dialog box.

Using Dynamic Tags

Dynamic Tags are tags used with an OPC UA server that you enter manually one at a time in groov. 
They are not configured on the OPC UA server. Dynamic tags allow you to add as many or as few 
tags to groov as you want making it easier to find specific tags if you only want to use a few.

Select an 
OPC UA server Click Update 

Static Tags
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Follow these steps to add dynamic tags to groov:
1. In the Configure Devices and Tags dialog, select the OPC UA server, and then click Configure 

Dynamic Tags.

2. In the Configure Dynamic Tags dialog box, click Add.
3. In the Add Dynamic Tag dialog box, enter a Name and select the Data Type.

You must also make sure the Data Type selected in groov matches the type retrieved from the 
device.

4. If this tag is an array of objects with the same data type, select Array and enter the array size.
5. Choose the Access Read or Write attributes as needed.

Leave this dialog box open while you identify the NodeId Value in the next step.

Select the 
server

Click Configure 
Dynamic Tags
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6. To find the NodeId Value for your device, open your OPC UA server configurator and find the 
configured device associated with this tag. 

You’ll find part of the NodeId information here. The remainder comes from the device itself. The 
addressing syntax is different for each type of device, so you’ll need to check the OPC UA 
server’s documentation for this tag’s device type.

As an example, here’s how you find the NodeId for an Rockwell Automation Logix tag on a 
KEPServerEX 5 server:

a. Open the KEPServerEX 5 Runtime configurator.
b. Locate the device and tag from which the dynamic tag in groov will obtain data.

Use this format for the NodeId Value:
[Channel name].[Device name].[Tag group name].[protocol specific address]
So now you can extract the information you need from the server’s configurator and the 
device itself:
[Channel name]=DTOL
[Device name]=Cmplx5370
[protocol specific address]=Program:MainProgram.i32Counter@Long

NOTE: The protocol specific address is obtained from the device. If you have a Kepware server, the 
help file provides the protocol specific addressing information. To access help for a specific tag, 
click on the device name in the Kepware configurator, choose Properties, and click the Help 
button.

In this example, the “@Long” portion specifies the data type as an unsigned 32-bit integer. This 
forces the server to report data to this type. If the default data type on the Kepware server is 
different than the tag’s data type, the link will fail in groov unless you specify the data type in the 
NodeId Value. For more information on your specific data type, see the server’s documentation.

Putting it all together, here’s the NodeId Value for this dynamic tag:
DTOL.Cmplx5370.Program:MainProgram.i32Counter@Long

7. In the groov Add Dynamic Tag dialog box you left open in groov Build, enter the NodeId Value.
8. In most cases, the Namespace Index should stay at 2. However, for some servers (such as 

Ignition by Inductive Automation) you should change the Namespace Index to 1.

A tag’s Namespace Index is an integer (0 or higher) that tells groov how to find the tag on the 
server.

9. Click Add Dynamic Tag.

Channel name

Device name
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10. Close the open dialog boxes.

The new dynamic tag appears in the Gadget Palette.

11. Now you’re ready to add gadgets to a page using the new tags you just created. For 
instructions, see “Adding Gadgets” on page 57.

12. After you’ve added some gadgets and associated tags to them, select File > Save All Changes 
and Switch to groov View.

It might take a few moments for the OPC UA connection to be established and live values to 
appear.

Configuring the Windows Firewall for an OPC UA Server

If you are using groov Server installed on a different computer than the OPC UA server or a groov 
Box, inbound traffic to the OPC UA server needs to be able get through the firewall on the port used 
by the server. This requires adding an Inbound Rule to the Windows Firewall on the computer where 
the OPC UA server is installed.

NOTE: If you are using groov Server and it is installed on the same computer as the OPC-UA server, you do 
not need to configure the Windows Firewall as described here. 

As an example, the following instructions describe how to add in Windows 7 the Inbound Rule for 
port 49320, the default port for the KEPServerEX 5 server. 
1. After you have successfully installed the Kepware server, open the Windows Control Panel.
2. If icons are displayed in the Control Panel, click Windows Firewall. If categories are displayed in 

the Control Panel, click System and Security and then click Windows Firewall.
3. In the left panel, click Advanced settings.

New dynamic tag
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The Windows Firewall with Advanced Security dialog box opens.

4. In the left panel, click Inbound Rules.

5. In the right panel, click New Rule.

6. For Rule Type, select Port. Click Next.

7. For Protocol and Ports, select Specific local ports and enter 49320 (the default Kepware port). 
Click Next.
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8. For Action, select “Allow the connection.” Click Next.

9. For Profile, select Domain and Private. Click Next.

10. For Name, enter a descriptive name such as “Kepware OPC-UA Server.”
11. Click Finish.
12. Exit the Windows Firewall and Control Panel dialog boxes.

Adding System Tags
You can get tags for information about groov itself and use them in your mobile interface. For 
example, you might want to show operators the current time and date. Or an Admin page might 
include system uptime, number of current user sessions, and so on. 

To make these tags available, you add System as another device. 
1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags, or select 

Configure > Devices and Tags.
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2. Click Add New Device and then select System.

3. System appears in the list of devices.

4. Click Close, and notice that System tags are added in the Gadget Palette. Click the plus signs to 
expand the tree and see all the tags.

All possible tags are shown in the list, but some may not 
apply to your groov. For example, groov Admin version 
applies only to a groov Box, not to groov Server. 

The table below shows information about the tags.

NOTE: It’s possible to choose an LED or Image Indicator gadget 
for Time or Date, but since time and date values are strings, you 
cannot set a numeric range for these gadgets. For example, you 
can set an LED to be blue at exactly 8:00 and black at any other 
time, but you cannot set it to be blue between 8:00 and 12:00. 
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System tags

Tag Meaning

groov > Admin Version
(groov Box only) Version of groov Admin running on the Box. (This 
information is also available in groov View; click the gear icon and 
choose About.)

groov > App Version
Version of groov App (Build and View) running on this groov. (This 
information is also available in groov View; click the gear icon and 
choose About.)

groov > groov CPU Usage (%) 
Current CPU usage by the groov software on either the groov Box or 
the PC where groov Server is running, shown as a percentage. A neg-
ative value means the current CPU usage is not available.

groov > groov Uptime How long groov software has been running

groov > groov Heap Usage (MB) Amount of memory allocated within groov software. Normal values 
depend on the size of your groov project.

groov > Number of Active Sessions
Number of user sessions currently viewing your groov interface. Typi-
cally the number of current users, but one user logged in through two 
devices or browsers will be counted twice.

Time > 

Time of day. For groov Server, the time on the PC groov Server runs 
on. For a groov Box, see the Box’s user guide to set time, set time 
zone, or synchronize with a time server. 
Choose the format you want. HH indicates a 24-hour clock; hh indi-
cates a 12-hour clock.

Date > 

From the groov Box or from the PC groov Server runs on. Choose the 
format you want. MM means the month is shown in digits; MMM 
means the month is written out. For example, DD MMM YYYY might 
appear as 26 Jul 2017.

Operating System* > 
System CPU Usage (%)

Current CPU usage for the whole system, shown as a percentage. A 
negative value means the current CPU usage is not available.

Operating System* > System Uptime How long the hardware (the groov Box or the PC groov Server runs 
on) has been running.

* Operating System refers to the hardware the groov software runs on, either the groov Box or the PC that 
groov Server runs on.
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Adding a Data Store
A Data Store provides a way in which users of your groov operator interface can interact with data 
from an online service, a database, or another software application. For example, your company’s 
SQL database could place production or maintenance data into a groov Data Store for users to see. 
Or your groov View users could enter production or service data for the database to pull in. 

Your application uses the groov REST API to either put 
data in groov or get data from groov. 

To see the full groov REST API, in Build choose Help > groov 
Public API, as shown at right. You can also find the API on 
developer.opto22.com. 

You add a Data Store for each application that will interact 
with groov, and then add the tags you want the application 
to read or write to. 

NOTE: A groov Data Store is another device in groov, like a Modbus/TCP serial device or a SNAP PAC 
controller. Devices cannot talk with each other directly. For example, a SNAP PAC cannot read data from a 
Data Store. However, you can use Node-RED in the groov Box (or on your PC) to create a logical flow that 
exchanges data between devices that have Node-RED nodes. For more on Node-RED, see nodered.org and 
the groov Box User’s Guide for GROOV-AR1 (form 2104). 

Here’s how to add a Data Store in groov:
1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags. Or select 

Configure > Devices and Tags.

2. Click Add New Device and then select Data Store.

http://developer.opto22.com/
https://nodered.org/
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
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3. Give the Data Store a name and click Create. 

The Data Store appears in the list of devices. 

4. Highlight the Data Store and click Configure Tags. Click the Add button  in the upper left.

5. Enter the following tag attributes:

Tag Name: (Required) Give the tag a descriptive name. 

Data Type: (Required) Select the data type that will be written to or read from this tag. 

Table: (Optional) If the tag is an array, check the Table box and enter the table length. From a 
practical standpoint, table length can be whatever you need (within the limits of your system’s 
capacity).

6. Click Save, or click Save & Add Another to add another tag. 
7. When your tag appears in the list, note the Tag Id; you will use it when accessing the tag.
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8. When you’ve finished adding tags, click Close. Click Close again and notice that your Data Store 
appears in the Gadget Palette with the name you gave it. Click the plus sign to see the tags in 
the store.

Editing a Device’s Address
If a device’s hostname or static IP address has changed, you’ll need to edit the hostname or address 
in Build.
1. Select Configure > Devices and Tags.
2. Select the server and click Edit Device.

3. For an Opto 22 controller or Modbus device, enter a new IP address or other information, and 
then click OK or Update Device.
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For an OPC UA server, enter a new name or server URL, then click Update Server.

4. Close the Configure Devices and Tags dialog box.

Deleting a Device
You can a remove a device from your project. However, be aware that any tags associated with 
gadgets will be lost and have to be reassigned.
1. Select Configure > Devices and Tags.
2. Highlight the device you want to remove and click Delete.

3. Click Delete Device.
4. Close the Configure Devices and Tags dialog box.

Adding Gadgets
There are two basic methods for adding a gadget and associating a tag. You can start with a gadget 
and add a tag to it. Or you can start with a tag and then add the tag’s gadget.

See “Method 1: Add a Tag to a Gadget,” page 58

See “Method 2: Add a Gadget to a Tag,” page 58
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Method 1: Add a Tag to a Gadget
Drag a gadget from a toolbox onto the page, and then assign it a tag.
1. Select the Gadget tab in the Gadget Palette.

2. Either double-click a gadget or drag it to the work area.
3. Select the gadget in the work area and look at the Gadget Properties panel (upper right).

4. Click the little tag next to No Tag Selected.
5. In the Update Tag for Gadget dialog box, click the plus signs to browse to the tag you want to 

use, select it, and then click Update Gadget. (Or just double-click the tag in the list.)
6. Configure the gadget’s properties. See “Configuring Gadget Properties” on page 60.
7. Choose File > Save All Changes.

Method 2: Add a Gadget to a Tag
Click a tag and assign an available gadget.
1. Click the Tags tab in the Gadget Palette panel, then click the plus signs to expand the tree and 

locate the tag you want. 

Expand the tag’s 
category
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2. Click the tag to see a list of gadgets that work with the selected tag.

3. Either double-click a gadget or drag it to the work area.
4. Configure the gadget’s properties. See “Configuring Gadget Properties” on page 60.
5. Select File > Save All Changes.

Editing Gadgets

Resizing and Moving Gadgets
When you resize or move gadgets in either the Desktop & Tablet layout or the Handheld layout, the 
change does not affect the other layout. See “Optimizing Layouts” on page 63 for more information 
on layouts.

• To move a gadget, grab it with the left mouse button and drag it. To move multiple gadgets, 
click on an empty part of your page and drag a box around the gadgets. Or hold down the CTRL 
key while selecting gadgets.

• To resize a gadget, click it, grab a graphic handle, and drag to the new size.

If a gadget is behind another gadget, you can make its sizing handles available by clicking on 
an exposed portion of the gadget.

Resize

Move

Sizing handles



EDITING GADGETS

groov Build and View User’s Guide60

Configuring Gadget Properties
To configure a gadget, click the gadget to display its Properties 
panel (in the upper right corner of the workspace). 

Each gadget has its own specific properties. For example, part of the 
LED Gadget Properties panel is shown at right. 

See Chapter 4: Gadget Reference for information on specific gadget 
properties.

Properties and Layouts
Any property with a link icon next to it can be changed in one 
layout (Desktop & Tablet, or Handheld) without affecting the other 
layout. See “Optimizing Layouts” on page 63 for more information 
on layouts.

Depending on the gadget, you can change the gadget’s label name, text size, alignment, color of 
text and its background, value precision, indicator colors, whether it is oriented vertically or 
horizontally, and more.

For example, suppose you want a gadget’s label to appear on the left side of the gadget in the 
Desktop & Tablet layout, but on the right side in the Handheld layout. Here’s how to change it.
1. Click the Desktop & Tablet tab, and then click the gadget you want to change.
2. In the Properties panel, make sure Alignment is to the left. 

3. Click the link icon so it changes to a broken link , indicating that changes to this property 
affect only the current layout. 

4. Click the Handheld tab and click the same gadget.
5. In the Properties panel, notice that the link is broken. Change Alignment to the right.

6. Check both tabs to see how the label on this LED will appear in the two layouts:

Link icon

Label alignment: left of gadget

Broken link

Label on left

Label on right
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Languages in Buttons and Labels

When adding text to a gadget, groov has full Unicode support and uses very common fonts such as 
Arial with broad support for most languages.

Cutting and Pasting Gadgets
• To cut or copy a gadget, right-click it to open the popup menu, and then select Delete, 

Duplicate, Copy, or Cut. 

• To paste a copied or cut gadget, left-click the workspace, then right-click and select Paste 
from the popup menu. 

• To select more than one gadget at a time, hold down the CTRL key as you click them. Or 
draw a box around multiple gadgets. 

As indicated on the popup menus, you can also use keyboard shortcuts for Copy (CTRL + c), Cut (CTRL 
+ x), and Paste (CTRL + v). Or choose Copy, Cut, or Paste from the Edit menu.

Moving a Gadget to the Front or Back
If gadgets overlap and you want to change the order of the stack, right-click a gadget and select 
Bring To Front or Send To Back. 

If you don’t want a gadget to move, choose Lock Position. 

Or choose Bring To Front, Send To Back, or Lock Position from the Edit menu.

Button gadget
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Aligning Gadgets
To align multiple gadgets, click on an empty part of your page and drag a box around the gadgets 
(or hold down the CTRL key while selecting them), then right-click and choose the alignment type. 
The Align commands are also available in the Edit menu.

Adjusting the Size of Multiple Gadgets
To make multiple objects the same size, drag the cursor around the gadgets (or hold down the CTRL 
key while selecting them), then right-click and choose how to size them. The Size commands are 
also available in the Edit menu.
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Optimizing Layouts
In groov Build there are two different layouts: Desktop & Tablet and Handheld. The Desktop & Tablet 
layout shows you how gadgets will appear when viewed on a computer monitor or a tablet. The 
Handheld layout is for viewing on a smaller handheld device such as a smartphone.

groov View automatically shows the appropriate layout for the device being used. Or, if you are using 
the groov View app for iOS or Android on a mobile device, you can choose which layout to view.

If most of your users will view your groov operator interface on a smartphone, you may want to start 
building your project in the Handheld layout tab. No matter where you start, you can adjust both 
layouts to optimize them for the people who will use them.

For any given page, by default both layouts contain identical gadgets and properties, but you can 
make the layouts different in several ways. 

To work on a layout, click the tab for either Desktop & Tablet or Handheld at the top of the page.

Desktop & Tablet layout

Handheld layout

Click tab
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You can switch between tabs as needed to make each layout the way you want. You can:

• Change a gadget’s size and position in one layout without affecting the other one. For 
example, you can move the most important gadgets to the top in the Handheld layout. See 
“Editing Gadgets” on page 59.

• Hide a gadget in one layout and show it in the other. See “Using the Page Stash” on page 24.

• Change the size, color, and alignment of gadget text in one layout only, for example to fit more 
on a smaller screen. But be careful not to make text too small to read or controls too small to 
use with your finger. See “Properties and Layouts” on page 60. 

• Show a different gadget label on one layout than on the other. See “Properties and Layouts” on 
page 60.

• Orient a gadget horizontally in one layout and vertically in the other. See “Properties and 
Layouts” on page 60.

Each gadget has individual properties that may limit or expand what you can do with it in a layout. 
See Chapter 4: Gadget Reference for information on each gadget. 
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Chapter 3

3: Managing groov

This chapter describes how to manage user accounts, back up and restore your project, update 
groov and your license, and more.

In this chapter:
Managing User Access ................................................................. 65
Managing Images in the Image Library ............................... 72
Adding a Page Category.............................................................. 76
Viewing the Tags in Use............................................................... 78
Viewing Log Messages................................................................. 79
Changing the General Project Settings ................................ 81
Saving Your Project and Opening groov View................... 82
Backing Up and Restoring Your Project ................................ 83
Updating groov ............................................................................... 85
Updating Your License ................................................................. 87

Managing User Access
When you build or change your groov project, you have specific ideas in mind about which people 
will use the mobile operator interface and which software applications will have access to groov 
data. Managing these people and applications—your groov users—within groov Build is the key to 
maintaining security. Here are some examples:

People—You may want a line operator to monitor and control equipment on the line, while a 
supervisor can see widget production but has no control over the equipment. Or you may want a 
central station to monitor equipment at remote sites, and field technicians to control it from a tablet. 

Software—It’s not just people who may need access to data in groov. You may also want software 
applications to access the data in a groov Data Store, using the groov API (application programming 
interface). For example:

• A company database could write daily sales totals for managers to see on their phones. 

• A custom application you’ve written in C++, .NET, JavaScript, or another programming 
language could share operational data from remote automation equipment, which then 
appears to technicians in groov View. 

• A cloud data service like AT&T M2X or Amazon Web Services (AWS) could provide data on 
trucks and freight containers to logistics personnel.

• A Node-RED flow you build could tweet status to operators when pressure is unusually low. 
(See the groov Box User’s Guide for GROOV-AR1 for more information on Node-RED.)

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
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Software clients that need to access data in groov must be added as users in groov Build. We 
recommend that each software client be assigned a unique username, password, and API key. That 
way, if multiple software applications are using the API and one becomes compromised, the others 
can still operate securely. 

Because security is a top priority, you will restrict access to your groov data and interface—or to 
parts of it—to make sure that only authorized people and software can use it, and only in the ways 
you intended. Here are three ways you can manage access: 

• Create an account for each user. Each person or software application that uses your groov 
operator interface or accesses its data must have an account with a username and password. 
When people use your groov interface, their passwords are encrypted. When applications 
access groov data, they must use their assigned API key to verify their identity. 

Make sure all users understand the importance of security, keep their passwords and API keys 
safe, and understand how to change them. 

See “Creating a User,” below.

• Create user groups to control page access. With multiple users, groups are an easy way to 
define who sees which pages. For example, you could create one user group for central station 
monitoring personnel and two groups for field technicians, and then assign each user to the 
correct group. The Central Station group sees pages showing all remote sites for monitoring. 
The Field Technicians West group sees pages with controls for their geographic area; the Field 
Technicians East group sees similar pages for their area. See “Managing User Groups” on 
page 70. 

• Create pages for specific purposes. If a line operator needs to monitor and control 
equipment, but a supervisor only needs to monitor it, create two pages, one for each purpose. 
The operator’s page includes controls; the supervisor’s doesn’t. See “Working with Pages” on 
page 21.

Creating a User

1. In groov Build, choose Configure > Accounts. Then click the Users tab.

2. Click Create New User.
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3. Enter a username for the new user.
4. If this user will receive email notifications from groov, enter the email address to use.

See Chapter 5: Using Events and Notifications.

5. Select a Role based on the security level for this user (Admin, Editor, Operator, or Kiosk).

For example, if you want a user to be able to log in and out of groov View and change their 
password, choose the Operator security level. If you want a user to use View but not be able to 
log out or change their password, choose Kiosk. 

For software users, choose Admin or Editor. Lower levels cannot access a groov Data Store.

This table shows the privileges available for each security level:

6. For Operator or Kiosk users, if you have already configured groups, select the groups the user 
belongs to.

Groups are used to restrict access to particular pages. For example, if a page is restricted to 
members of the group called West Wing, then a Operator or Kiosk level user must be in the 
West Wing group to access that page. See “Managing User Groups” on page 70.

Security Level

Admin Editor Operator Kiosk

P
ri

vi
le

g
e

Use and interact with the gadgets in 
groov View    *  *

Log out and back in, and change their 
password in groov View    *

Use groov Build to add devices, make or 
change pages, & set groups on pages  

Use the groov API to securely access 
data in a groov Data Store  

Create users and groups, assign users to 
groups, and generate new API keys 

* Only for the user groups an Operator or Kiosk user belongs to. See page 70.
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7. Click Create User.

The user appears in the list.

8. Give the username and password (for a person) or API key (for software) to the user. 

API keys are automatically generated. To change an API key, see “Changing a User’s Settings,” 
below.

Finding a Software User’s API Key 
1. In groov Build, choose Configure > Accounts. Click the Users tab. 

2. Find the user in the list (if you have a long list of names, use the Filter by name field to help). 
Read across from the username to the API Key column.

Changing a User’s Settings
1. In groov Build, choose Configure > Accounts. Click the Users tab. 
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2. Find the user you want to change (if you have a long list of names, use the Filter by name field 

to help). Click the edit button  in line with the user’s name.

3. Change the user’s settings as needed. (See more information in “Creating a User” on page 66.) 
Note two things you can do here that weren’t available when you first created the user:

– API Key (applies to software users)—Click Generate to assign a new API key (you cannot 
create your own). After you update this user and return to Manage Accounts, you’ll see the 
new API key. The old key is automatically disabled.

– Password change—You can assign the user a new password here, or check the box if you 
want to force the user to change their password the next time they log in. (Note that the 
user’s current password is not visible. There is no way to retrieve a user’s current password, 
but you can assign a new one or require them to change theirs.)

4. Click Update User.
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Deleting a User Account
A deleted user will no longer be able to log in.
1. In groov Build, choose Configure > Accounts, then click the Users tab.
2. In the list, find the user you want to delete (if you have a long list, you can use the Filter by 

name field to find it). Click the trash can button  in line with the user’s name.

A confirmation message appears.

3. Click OK to confirm.

Managing User Groups
Groups are used to restrict access to particular pages for Operator and Kiosk level users. For example, 
if a page is restricted to members of the group called West Wing, then an Operator or Kiosk level user 
must be in the West Wing group to access that page. 
1. To work with groups, in Build choose Configure > Accounts. Then click the Groups tab.

– To delete an existing group, find the group name in the list (if you have a long list, you can 
use the Filter by name field to find it). Click the trash can button  in line with the group 
name.

– To create a new group, click Create Group. 

– To edit an existing group, find the group name in the list and click the edit button  
in line with the group name.
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2. Enter or change the Group Name, select the users to be included in the group, and select the 
pages to be included in the group. 

NOTE: You must have already designated page permissions as Limited Access, or the page will not 
appear here. To change a page’s permissions, cancel this dialog box. In Manage Accounts, click the 
Pages tab. Find the page you want to change and click the edit button in line with the page name. 
Under Access Rights, choose Limited Access. For more information on page permissions, see 
“Changing Page Properties” on page 22.

3. Click Create Group (or Update Group). 

Changing a User’s Password
How passwords are changed depends upon the user’s security level.

• An Admin level user can change any user’s password; see “Changing a User’s Settings” on 
page 68. 

• Admin and Editor level users can change their own passwords in either Build or View. 

• Operators can change their passwords in View. 

Changing your password in Build: 
Choose Security > Change Password.



MANAGING IMAGES IN THE IMAGE LIBRARY

groov Build and View User’s Guide72

Changing your password in View: 
Click the gear icon and select Change Password.

Fill in the form with the old and new passwords; then 
click Change Password.

Logging Out Users
An Admin user can log out all logged-in users in one step. The users will no longer be able to get 
gadget updates, write values, or change pages.

In Build, choose Security > Log Out All Users.

Managing Images in the Image Library
All images you use in your groov project are stored in the Image Library. You can use the same image 
in any number of places in your project, and if you change the image, it is updated everywhere it 
appears. 

groov accepts many different kinds of images, including photos, drawings, and logos with file types 
of BMP, GIF, PNG, JPG, and SVG. You can even use an animated GIF. For best performance, use images 
no larger than 2000 x 2000 pixels at 72 dpi with 8-bit color information, or a total of less than 300 KB 
in size per image. 

You can upload images you make or obtain yourself and any of the drawings in the SVG Library on 
the groov.com website. If you have Microsoft Visio 2003, you can also make a compatible image 
using any of our free Visio libraries. 

You can use images in a variety of ways:

http://groov.com/svg-library/
http://groov.com/svg-library/
http://www.opto22.com/lp/visio_libraries.aspx
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• Use multiple images in the Image Indicator to show status or value (see page 105).

• Put your logo in the caption bar at the top of the page (see Groov View Styling in “Changing 
the General Project Settings” on page 81).

• Orient your users by showing an image of the location or device they’re monitoring.

• Skin a button with an image (see page 97, page 98, and page 99).

• Use an image as a link to another page or Internet location (see page 92).

One caution: It’s easy to overdo the use of images. Make sure you don’t clutter your operator 
interface with unnecessary graphics. Animations are especially distracting for users and should be 
avoided. Use images that will help your users, not distract them from what’s important on the 
screen. 

Adding Images
You can add images to the Image Library directly, or you can add them while you’re assigning 
properties to gadgets. 

Adding Images Directly to the Image Library

1. To add images directly to the Image Library, choose Configure > Image Library. 

2. Either click Add New Images and browse to the location of the image or images you want, or 
just drag the image(s) from their current location into the Image Library. 
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3. (Optional) Click inside the Notes area to add your own notes about the image.

Adding an Image to a Gadget

1. To add an image while you’re setting the gadget’s properties, make sure the gadget is 
highlighted. In the Properties panel (upper right), depending on the gadget, click Add Image or 
choose Display Mode > Image and click the broken image button.

2. In the Image Library, select the image you want. Or click Add New Images, browse to the 
image, click Open, and then select it in the Library. 

The library closes and you return to the main workspace to choose image properties. See 
Chapter 4: Gadget Reference for details on each gadget.

Changing Image View
To see more details about the images in the library, or to view more images in the same space, 
choose a different view at the top of the library.
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Image details view (default)

Image basics view
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Changing an Image
If you change an image, you can upload the new version to replace 
the older one in the Image Library. You must have already made the 
change to the image in another software program.
1. Choose Configure > Image Library and locate the image you 

want to change.
2. Click the pencil icon at the left of the image and browse to the 

new version of the image. Click Open to replace the image.

Deleting an Image
1. Choose Configure > Image Library and locate the image you 

want to delete.
2. Click the trashcan icon at the left of the image.

The image is deleted.

Adding a Page Category
If you have a large project, you can organize pages in the operator interface by creating categories 
and assigning pages to them. 

For example, if you have a multi-story building, you could make a category for each floor, and then 
add pages to it that apply only to that floor. Or categories can represent individual machines, or 
rooms, or any number of things. 

Image thumbnails view
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When you create a new category, make sure to add at least one page to the category. Otherwise, the 
category will be deleted automatically when you save and open View. Also see “Working with 
Pages” on page 21.
1. In groov Build, click Add Category under Pages on the left side.

2. Type a new name for the category. 

3. Click OK.
4. To put existing pages in the new category, in the Pages panel, use your mouse to drag and 

drop them below the new category name.

Deleting a Category
The process for deleting a category is similar to deleting a page. However, you can only delete a 
category that doesn’t have any pages assigned to it. To delete a category with pages, first move or 
delete the pages. 
1. Hover over the page or category name in the Pages panel, then click the red X that appears.

Drag existing pages below 
the new page category.

Click the red X.
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2. Click OK.

Renaming a Category
1. Right-click the name and select Rename.

2. Enter a new label, and press Enter or left-click in the work area.

Viewing the Tags in Use
To see all the tags being used in your project, select View > All Tags. The Tags in Use dialog box 
shows the tags in use and the gadget or event they are used in, the controller, and the page in your 
groov project. 
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Click “Sort by” in the upper right to sort tags alphanumerically by tag name, controller, page, or 
gadget. 

In the Page column, you can click the page name to go to the page. To return, choose View > All 
Tags again. 

Viewing Log Messages
groov continually logs messages about what it’s doing, including all activity that occurs while you 
are using groov, as well as events and event notifications. Seeing these messages in the Log Viewer 
can help you troubleshoot issues or track groov progress. All messages are logged, but you can 
choose what you want the Log Viewer to show.

If you want to see the Event Message Logs, see “Viewing Events” on page 119.

Here’s how you use the Log Viewer:

• To view log messages, choose Help > View logs.

The Log Viewer opens, showing the most recent 5000 messages. New messages are added to 
the Viewer as they occur and continue to be added until you close the Viewer. If you reopen it 
later, it will again show the most recent 5000 messages; older messages you saw before will not 
appear.

• To save all messages to a text file, click Download Logs. You can open the text file in 
Notepad or save the text file. This saves all of the messages, not just the ones currently in the 
Viewer. (For Admin/Editors only.)
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• To clear the messages currently in the window, click Clear. This action does not clear all 
logged messages; you can retrieve them by clicking Download Logs. (For Admin/Editors only.)

• To pause or resume new messages being shown, click Pause or Resume.

• To filter messages by priority/log level, choose the level from the Minimum log level 
dropdown menu and then click Apply. When applied, logs having a priority below the selected 
level will not be shown. For example, selecting WARN excludes all INFO, DEBUG and TRACE 
level logs from the display.

– TRACE: Extremely fine-grained information. This level is primarily for diagnosing problems 
with the help of Opto 22 Product Support.

– DEBUG: Fairly fine-grained information. Primarily for diagnosing problems with the help of 
Opto 22 Product Support.

– INFO: Messages about the general progress of the app.

– WARN: Information about unusual situations that may indicate a problem in groov or that 
groov is improperly configured.

– ERROR: Errors within groov that typically don’t affect how groov runs.

– FATAL: Problems that cause groov to crash.

• To filter messages using a text string, enter the string in the Contains string field and click 
Apply. Only the messages that contain the string in the message body are shown. This filter is 
applied not just to messages currently in the window, but to all messages.

INFO messages are likely to be the most useful.
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• To diagnose problems when working with Opto 22 Product Support, they may ask you 
to click the Advanced Configuration link to display a file that provides special features.

Changing the General Project Settings
This section describes the General Settings for your project. To set up a groov email account, see 
“Setting Up Notifications” on page 121.
1. Select Configure > Project.

2. In the General Settings box, configure the following options:

– Default video gadget refresh period—Sets how often in seconds groov refreshes the 
image from an IP camera. Use this option to set the default refresh period for video 
gadgets. The minimum video refresh rate is 0.5 seconds. Every instance of the video gadget 
will use this refresh period unless a different refresh period is set for an individual instance. 
To set an individual instance, see “Video Gadget” on page 93. For more information on how 
to use this setting, see “Changing the Video Gadget Refresh Period” on page 158.

– Do not expire Kiosk user login sessions—Use this setting if you want kiosk users never 
to be logged out. This is helpful for TVs or other displays not associated with a particular 
user that need to remain on for long periods of time. Normally, a login lasts two weeks. If 
you have kiosk users, also see “Automatic Refresh” on page 134. 

3. To change the look of your groov project (colors, logo, and so on), scroll down to the Groov 
View Styling box. 
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4. Configure the following options:

– Show in groov View
Page List—If you deselect this option, any user using View can only see the first viewable 
page. All other pages will not be available to view.
groov Logo—Deselect this option to hide the groov logo. You can replace it with your own 
or have no logo. 

– Freeze caption bar
Check this box if you want the top bar (with or without a logo) to remain fixed at the top of 
the page, even when your user scrolls down.

– Logo
Default—Either the groov logo or no logo will appear, based on your choice above.
Custom—To show a logo other than groov, click Custom and then click Choose Image. In 
the Image Library, locate or upload the image you want to use. A logo larger than 135 x 35 
pixels will be resized smaller. 

– Menu color and Caption bar color
Click the box to change the default colors to match your brand or taste. Choose colors from 
the samples shown.

5. Scroll to the top and click Save Settings, and then click Close.

Saving Your Project and Opening groov View
Click the File menu and select one of the following.

Save All Changes—Saves your latest changes, but it does not update any open iterations of View.
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Save All Changes and Switch to groov View—Saves your latest changes and opens an updated 
groov View.

Switch to groov View—Opens groov View without incorporating any changes you have made 
since your last save.

Open groov View in New Tab—Use this option if you want to have both groov Build and View 
open at the same time in separate tabs.

To back up your groov project, see the next section.

Backing Up and Restoring Your Project
You should back up groov frequently, because there is no automatic backup. During backup, your 
project is saved to a file on your computer. groov project backups are interchangeable between the 
groov Box and groov Server. So you can restore to groov Server a project you backed up from a groov 
Box, and vice versa. 

If you have two groov Boxes or Servers at different versions of groov and you want to move a project 
to the older version, it will usually work only between lettered versions. For example, moving a 
project from a groov at R3.3b to a groov at R3.3a should be OK, but moving from R3.3 to R3.2 is not 
likely to work. It’s safest to keep your groovs at the same release. 

If you are using a groov Box, you can also back up using groov Admin. For more information, see 
form 2104, the groov Box User’s Guide for GROOV-AR1 or form 2077, the groov Box User’s Guide for 
GROOV-AT1.

IMPORTANT: Your groov project files are not encrypted or masked in any way. This means that most of 
the project information in them (except for the groov User passwords) can be read, including the following:

• SMTP account info (including password)

• User email accounts (does not include the groov User passwords, which are securely encrypted 
before being stored)

• Device addresses

• Tag address information (PAC tag names, Modbus addresses, OPC node-id, etc.) 

Opto 22 recommends that you secure your backup files using file- or disk-based encryption provided either 
by the operating system or other software/hardware.

Also, be aware that if you send project files to Opto 22, our personnel will have access to the information 
listed above.

To back up your project, select File > Backup Project to Computer. A backup file is saved to the 
Downloads folder on your computer.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4382
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To restore your project from a backup file:

CAUTION: Only restore your project if you have to. You will lose all work done since the last backup, and 
all users will be logged out.

1. Select File > Restore Project from Computer.

2. In the Restore Project dialog box, browse to your Download folder to locate the tar.gz backup 
file.

3. Enter the username and password for the Admin account.
4. Click Restore.

The following warning appears.
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5. If you are sure you want to proceed, click OK.

When the restoration process is complete, the restored project opens in groov View.

Updating groov
You are eligible to receive groov updates as long as your license is active. Updates add new 
capabilities and fix issues that may arise. 

Each groov installation is treated independently, so you must activate each one; updates are valid for 
a specific groov installation only.

To see your version of groov:

• In groov Build, choose Help > About.

• In groov View, click the gear icon and choose About.

Checking for Updates

If updates are available, an updates icon appears next to the groov logo in the upper-right corner of 
groov Build. Click the updates icon (or select Help > Check for Updates). 

The Check for Updates dialog box tells you what kind of updates are available. Follow the onscreen 
instructions to download an update file or view a list of updates on the latest groov readme.

Another way to check for updates is to go directly to manage.groov.com. If there is an update 
available for your groov, download the file. To install an update file, follow the instructions below for 
groov Server for Windows or groov Box.

Click the 
updates icon

http://manage.groov.com/
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Before updating the application, make sure to save any changes in your project so that they will still 
be there after the update takes effect.

Installing Updates on groov Server for Windows
To install an update for groov Server, double-click the downloaded update file and run the 
installation.

Installing Updates on a groov Box
To install updates on a groov Box you must use the groov Admin app. For more information about 
groov Admin, see form 2104, the groov Box User’s Guide for GROOV-AR1 or form 2077, the groov Box 
User’s Guide for GROOV-AT1.
1. To open Admin, select Configure > groov Admin.

2. Click Quick Start and then the Update groov App button.

3. Click Choose File, navigate to the update file you downloaded, and then click Open.
4. Click Update.

Wait while the application is installed and restarted automatically, which may take several 
minutes. When the operation is complete, a success message appears.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4382
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Updating Your License
In order to use updates for groov or the options added in groov Plus and groov Enterprise, your 
license must be up to date. You may need to download and install a new license. For more 
information, see the groov Maintenance Technical Note.

IMPORTANT: You must be logged into groov Build as an Admin in order to update your license. (If you’re 
using a groov Box, make sure you use the Admin username and password for groov Build, not for the Box.)

To check the enabled options and expiration date, select Configure > Licensing (this menu 
item appears only if you are logged into groov Build as an Admin user). The expiration date appears 
under License type.

When your license is about to expire, a small notice appears when you first open groov Build to 
remind you to renew. Once the license has expired, you’ll see a similar notice:

License agreement 
expiration date

Click in the middle of the notice to go to the 
Licensing dialog box and renew your license. 
Or if you’re not ready to renew, click the small x 
to dismiss the notice.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4485
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To update your license:
1. Click the manage.groov.com link or go to: manage.groov.com 

Follow the on-screen instructions to purchase continued maintenance and acquire a new 
license file.

2. Save the license file to your computer.
3. Come back to the License Management dialog box (Configure > Licensing) and click the Select 

License File button.
4. Browse to the new license file, highlight it, and then click Open.
5. An Upload Successful message appears in the License Management dialog box.
6. Click Close.

manage.groov.com
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Chapter 1

4: Gadget Reference

groov Build provides a collection of gadgets that allow you to create a graphical, on-screen operator 
interface to monitor and manage Opto 22 control applications (or strategies) running on Opto 22 
SNAP PAC controllers, OptoEMU sensors, and a wide variety of other systems and devices.

This chapter provides details on how to configure gadget properties.

Gadget Go to

page 90
page 91
page 91
page 92
page 93
page 94
page 95
page 96
page 97
page 98
page 99
page 100
page 101
page 102
page 103
page 104
page 105
page 106
page 107
page 108
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Group Header Gadget
Use the Group Header gadget to visually define a group of objects. Group related gadgets in the 
same area and place a Goup Header as a box behind them. The box ties them together visually so 
operators know at a glance that they are related. 

TIP: If you need to move a Group Header (or any other gadget) behind another gadget, right click it and 
choose Send to Back.

Other gadgets placed on top

Align title at the left, center, or right. Default is left.
Choose title text size. Default is 12. 
Choose title font. Default is Arial.
Make title bold, italics, or both. Default is bold.
Change title text color (click the rectangle and choose).

Enter a title for the group.

Group Header 
gadget

NOTE: For any property with a link button, you can click to 
break the link and choose the property value independently for 
Desktop & Tablet versus Handheld layouts. See “Properties and 
Layouts” on page 60.
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Line Header Gadget
Use the Line Header gadget to provide a label or title for organizing gadgets on a page. 

Divider Gadget
The Divider gadget provides a simple gray horizontal or vertical line to separate groups of objects. 
You can make the divider longer or shorter by selecting the object and dragging its handles.

Align title at the left, center, or right. Default is left.
Leave title text size at Auto or choose size in pixels. 
Choose title font. Default is Arial.

Make title bold, italics, or underlined. Default is 
underlined, and the underline extends past the title 
to the full width of the gadget.

Change title text color and background color (click 
the rectangle and choose).

Enter title text.

NOTE: For any property with a link button, you can click to 
break the link and choose the property value independently for 
Desktop & Tablet versus Handheld layouts. See “Properties and 
Layouts” on page 60.

Horizontal or vertical
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Page Navigator Gadget
Use the Page Navigator gadget to link to another page in the project, to groov Event Status or Event 
Logs, or to a web page. The gadget can be displayed as a text link, a button, or an image.

• To link to a page in your groov project, select the page from the list or search on the page name 
(or partial name).

• To link to Event Status or Event Logs, just choose it in the Link To dropdown list.

• To link to a web page, choose Web Page in the Link To dropdown list, and enter a full URL (for 
example, http://opto22.com). 

Page navigator gadget Display Modes

Button

Image
Choose whether to show 
the link as text, a Button, or 
an Image. 

Link

For a link or a button:
Enter the text for the link.
Leave link text at Auto or enter size in pixels. 
Choose title font. Default is Arial.
Make title bold, italics, or both. Default is neither.
Change title text or background color 
(click the rectangle and choose).

For an image:
Click the broken image button and choose an 
image from the Image Library (see page 72).

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.

To change how transparent an image is, enter a 
value between 0 and 100. Zero is completely 
transparent (invisible); 100 is completely opaque.

Choose where the link goes.
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Video Gadget
The Video gadget displays iFrame type video images from an IP camera; it does not interact with 
controller points/variables.

For information on entering a URL and setting up IP cameras, see the appendix on page 155 and 
your IP camera or server documentation.

Camera URL—Enter the URL of an IP camera or video server that provides access to your IP 
camera’s static image feed. If you are using a video server, use the server’s URL. For more information 
on entering a URL, see the appendix on page 155. 

Update Period—Set how often in seconds groov updates the image from an IP camera for this 
individual video gadget. To set the default update period for all video gadgets, see “Changing the 
General Project Settings” on page 81. For more information about this setting, see “Changing the 
Video Gadget Refresh Period” on page 158.

Use groov as a proxy—This feature provides a secure reverse proxy service for the video gadget. 
This service is useful when viewing from outside a firewall. 

When the box is checked, the 
video gadget requests video from 
groov, which authenticates and 
forwards the request to the IP 
camera, eliminating the need to 
configure the firewall for each IP 
camera. 

In this case, groov will poll the IP 
camera over the local network at 
the set update period (in seconds) 
and buffer the images. When you view your groov project, you will see the images over the same 
secure connection as the rest of your groov project.

When the box is not checked, the 
video gadget requests video 
directly from the IP camera. You 
must configure the firewall to 
allow the video feed for each IP 
camera. 

Maintain aspect ratio—Check 
the box to keep the video at the same height-to-width ratio when the video gadget is resized.

Video gadget

groov groov View

IP camera

groov

IP camera

groov View
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Test Feed—Click the button to test the live IP camera feed in Build. 

Image Gadget
Use the Image gadget to place an image in your project. See more about using images in 
“Managing Images in the Image Library” on page 72.

Click here to open 
the Image Library.

Image gadgets

To change how transparent an image is, 
enter a value between 0 and 100. 
Zero is completely transparent (invisible); 
100 is completely opaque.
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LED Gadget
An LED is a read-only gadget that typically indicates the state of a numeric value. It can be used with 
boolean tags (on/off, true/false), with numeric values with multiple colors to indicate an exact value 
or a range, or with string values with multiple colors to indicate an exact match. For boolean tags, 
the LED is off when the value is 0 and on when the value is non-zero.

LED on

LED off

On and Off states for a blue LED

Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.

Change label text or background color (click the 
rectangle and choose).

Leave graphic size at Auto or choose size in 
page grid units. 

Enter a label for the LED.

Align label on the left or 
right side of the LED. 
Default is left.

For a boolean tag: 
Click the colored circle and choose 
colors to indicate LED is on (True) or 
off (False).

NOTE: For any property with a link button, you can click to break the link 
and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.

For a non-boolean tag: 
Click the Add Range button to set 
colors for each range. 

Enter a specific value for Exact, or the start and end values for Range. 

Choose the range color.

Click to close editor for this range. 
To add another, click Add Range.

LEDs with multiple colors

Choose when the color should appear:
Exact: Color appears for the specified value. 
Range: Color appears for any value within a range.
Negate: If checked, color appears if value is outside the specified 
value or range.
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Checkbox Gadget
The Checkbox gadget is a read/write binary input which your user can toggle on or off by selecting 
the box. Off = zero, On = non-zero. 

 

Checkbox gadgets

NOTE: For any property with a link button, you can click to 
break the link and choose the property value independently for 
Desktop & Tablet versus Handheld layouts. See “Properties and 
Layouts” on page 60.

Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.
Change label text or background color (click the 
rectangle and choose).
Leave gadget size at Auto or choose size in 
page grid units. 

Enter a label for the Checkbox.

Align label on the left or right side of the LED. Default is left.

Click to require confirmation 
before a write.
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Indicator Button Gadget
The Indicator Button gadget is a read/write binary button which your user can toggle on or off by 
clicking it. Off = zero, On = non-zero. This gadget can be displayed as a button (with an integral 
color to show status) or as two images (one for On and one for Off ). See more about using images in 
“Managing Images in the Image Library” on page 72.

Button display—configurable color

Button off

Button on

For a button: 
Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.
Change colors for On/Off indicator, button text, and button 
background (click the rectangle and choose).

For a button, enter a label for 
the Checkbox.

NOTE: For any property with a link button, you can click to 
break the link and choose the property value independently for 
Desktop & Tablet versus Handheld layouts. See “Properties and 
Layouts” on page 60.

Choose whether to display a 
button or images.

Click to require confirmation 
before a write.

For an image:
Click here to open the Image Library 
and choose an image to show when 
the button is On. 
Choose a second image for when the 
button is Off.

Opacity: To change how transparent an image is, enter 
a value between 0 and 100. Zero is completely 
transparent (invisible); 100 is completely opaque.

Image display

Button on

Button off
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Command Button Gadget
The Command Button gadget sends a value to a numeric or string variable. The value is sent once 
when the button is pressed. 

Optionally, in addition to writing a value, the button can also immediately navigate to a groov page 
(a page you’ve created, the Event Status page, or the Event Logs page) after successfully writing the 
value. The target page opens in the same window. 

This gadget can be displayed as a button or as an image. See more about using images in 
“Managing Images in the Image Library” on page 72.

Command button gadgets—Display Modes

Buttons

Image

For an image:
Click here to open the Image Library.

To change how transparent an image is, enter a value 
between 0 and 100. Zero is completely transparent 
(invisible); 100 is completely opaque.

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.

For a button: 
Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.
Change colors for On/Off indicator, button text, and button 
background (click the rectangle and choose).

For a button, enter a label for 
the button.

Choose whether to display a 
button or an image.

Click to require confirmation 
before a write.

Enter the value to write.

(Optional) To also open a 
page, choose the type 
(and name) to open.
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Momentary Button Gadget
The Momentary Button gadget simulates a normally open button. It writes a value once when it is 
pressed, and another value once when released. This gadget might be used to drive a motor to raise 
and lower a crane, or to start and stop a drill. You can choose to display the button as a button or as 
an image. See more about using images in “Managing Images in the Image Library” on page 72.

For a boolean tag, select either True or False for the Press Value. 

For integers and floats, enter both a Press Value and a Release Value. Optionally, you can also enter a 
Toggle Value. When a Toggle Value is entered, while the button is pressed it will alternately write the 
Press value and the Toggle Value once per second. The Press value is always written first. When the 
button is released, the Release Value is written. 

For a boolean tag, select 
either True or False. 

Momentary button gadget—DIsplay Modes

For an integer or float, select a Press Value and a Release Value, and 
optionally a Toggle Value. 
A Toggle Value can help you detect a communication failure. Use 
controller logic to detect the failure while the button is pressed, and 
to implement a failsafe if needed. 

For an image, click here to open the Image Library.

To change how transparent an image is, enter a value between 0 and 100. 
Zero is completely transparent (invisible); 100 is completely opaque.

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.

For a button: 
Enter a label for the button.
Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is 
neither.
Change colors for button text and background 
(click the rectangle and choose).

Choose whether to display a 
button or an image.

Choose whether to display a button or an image.

Buttons

Image
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Slider Gadget
The Slider gadget is a read/write gauge that displays an analog or float-type value using a horizontal 
or vertical bar that fills to indicate the present position or value. This gadget is the same as the level 
indicator gadget except that a user can grab and move the slider button to change the value and 
write it to the controller. You might use this gadget for room temperature setpoints, alarm values, 
PID settings, and so on.

Enter the slider’s minimum and maximum values.

Enter the number of places to the right of the decimal 
point to be displayed.

Check to require confirmation before a new value is written.

Check the box to continually write values as the slider is 
dragged. If unchecked, value is written once you let go.

Choose to show the value as a value or a percent, or choose 
not to show the value.

Enter Engineering units for the value (gallons, amps, etc.).

Choose a horizontal or vertical slider.

Value

Color

PrecisionLabel

Button

Leave text at Auto or enter size in pixels (controls both 
label and value text, if shown).

Enter a title (label) for the slider.

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.

For the value (if shown):
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

Change the slider’s indicator color or background.

Leave gadget size at Auto or choose size in page grid units. 

For the label:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).
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Level Indicator Gadget
The Level Indicator gadget is a read-only gauge that displays an analog or float-type value using a 
horizontal or vertical bar that fills to indicate the present position or value. You might use this 
gadget for a fuel gauge or a noise-level indicator, for example.

Value

Color

PrecisionLabel

Enter the slider’s minimum and maximum values.

Enter the number of places to the right of the decimal 
point to be displayed.

Choose to show the value as a value or a percent, or choose 
not to show the value.

Enter Engineering units for the value (gallons, amps, etc.).

Choose a horizontal or vertical slider.

Leave text at Auto or enter size in pixels (controls both 
label and value text, if shown).

Enter a title (label) for the slider.

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.

For the value (if shown):
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

Change the slider’s indicator color or background.

Leave gadget size at Auto or choose size in page grid units. 

For the label:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).
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Text Area Gadget
The Text Area gadget is a read-only gadget for displaying numerical or string data. Enter text just as 
you want it to appear, and use enough pound signs (#) to accommodate numeric data to be 
displayed. For example, ##.# could display 35.0, and ###.## could display 350.86. For string data, just 
use one #. 

Enter text and enough pound 
signs (#) to display the tag’s value.

DataText

Background

Align text at the left, center, or right within the 
gadget. Default is left.
Align text at top, middle, or bottom within the 
gadget. Default is middle.

Choose text text size. Default is 12. 

Make text bold, italics, or both. Default is neither.

Change text or gadget background color (click 
the rectangle and choose).

Choose text font. Default is Arial.

NOTE: For any property with a link button, you can click to break 
the link and choose the property value independently for 
Desktop & Tablet versus Handheld layouts. See “Properties and 
Layouts” on page 60.
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Text Box Gadget
The Text Box gadget is a write-only field that your user can change to send numerical or string data. 
When the user clicks in the Text Box, a dialog box pops up for entering data. Data is sent when the 
OK button is clicked or tapped.

Select a text box size for user input. 
If you choose Unlimited, you cannot 
enter a label.

For numerical data, enter the minimum and 
maximum values your user can enter.

Enter a label (title) for the Text Box.

Label

Value

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.

Enter pre and post prompts for the Edit 
Value dialog box. The pre-prompt 
appears above the value they enter. The 
post-prompt appears below it, for 
example to indicate units.

Leave text at Auto or enter size in pixels (controls both 
label and value text).

Enter a title (label) for the slider.

For the value (if shown):
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

For the label:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

Change gadget background color.

Pre-prompt
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Value Gadget
The Value gadget is a read-only gadget for displaying numerical or string data. It has a uniform 
width to make it easy to line up multiple gadgets. The text format changes depending on the tag 
type, so you don’t have to configure it manually. For example, a float-type tag will have #.##, while 
an integer tag will have just #. 

If you use a boolean tag, you can use the default ON and OFF text for true and false values, or enter 
your own labels, such as Running and Stopped. In the Label text box, enter text just as you want it to 
appear. The data will be blue, but the label text will be black.

DataLabel
Format is entered for you based on the 
tag you choose. To add precision on a 
float, enter additional pound signs (#) 
after the decimal point. 
For a string, use the default of #.## 
For boolean tags, you can customize 
the true and false text.

Leave text at Auto or enter size in pixels 
(controls both label and value text).

Enter a label for the value.
Align label at left or right of value.

For the value:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

For the label:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

Change gadget background color.

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 60.
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Image Indicator Gadget
With the read-only Image Indicator gadget, you can use multiple images to represent the changing 
values of a tag. For example, you can use one image to indicate that a pump is on and one to 
indicate that it’s off. Or show different images of a tank depending on how full the tank is. 

The Image Indicator can be used with boolean tags (on/off, true/false), with numeric values with 
multiple images to indicate an exact value or a range, or with string values with multiple images to 
indicate an exact match. 

You choose each image you want to use from the Image Library and assign the status or value range 
to that image. (See “Managing Images in the Image Library” on page 72.) 

Click to add image.

To change how transparent the image 
is, enter a value between 0 and 100. 
Zero is completely transparent 
(invisible); 100 is completely opaque.

Image currently added

Click to change this image.

Image Indicator gadget changes the image based on 
the value of the tag (only one image appears).

Choose when the image should appear: 
Exact: Image appears for specific value. 
Range: Image appears for any value 
within a range.
Negate: If checked, image appears if the 
value is outside the specified value 
or range.

Enter exact value; or for a range, enter 
Minimum and Maximum Values.

Click to close editor for this image. 
Click Add image again to add the next image.
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Round Gauge Gadget
The Round Gauge gadget is a read-only gauge that displays an analog or float-type value using a 
rotating needle and decimal numerical display to indicate the present value. Possible uses include 
water or gas pressure gauges, the speed of a conveyer belt, and so on.

Enter the gauge’s minimum 
and maximum values.

Choose colors for the 
needle and the gauge’s 
background.

Enter the number of places to the right 
of the decimal point to be displayed.

Enter Engineering units (gallons, PSI, etc.).

Enter the start and end values for this 
range. These must be not more or less 
than the gauge’s Min and Max values.

Check to display the value in the gadget.

Click here to add a color as a 
range indicator on the gauge.

Choose the range color.

Choose Custom to 
override the default tic 
marks. See descriptions 
above left.Click to close editor for this range. 

To add another, click Add Range.

Current Value
Units

Range color

Needle color

Max Value
Min Value

Range Start Value

Range End Value

Panel continues at left.

Panel continued from right.

If the value is very large (for 
example, 50,000 kilograms), 
you can scale the value so 
numbers are more readable.

For the markers around the gauge:
Leave at Auto or choose size. 
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

For the current value:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. Default is bold.
Change color (click the rectangle and choose).

More on Markers
For both major and minor intervals, if you use 
the default (0), groov calculates the optimum 
number and spacing of tic marks to show on 
the gauge. 
If the Custom intervals you enter create more 
than 200 tic marks (major and minor 
combined), groov overrides your entries and 
sets the number and spacing so markers and 
values are legible. (Your Custom entries still 
appear in the Properties panel but are not 
used.)

NOTE: For any property with a link button, 
you can click to break the link and choose the 
property value independently for Desktop & 
Tablet versus Handheld layouts. See 
“Properties and Layouts” on page 60.
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Range Indicator Gadget
Use the Range Indicator gadget to show on a horizontal or vertical scale where data appears in a 
range of numbers. This gadget is commonly used as a thermometer, but it can indicate any kind of 
data within a range. If you arrange several of these together on a page, an operator can tell at a 
glance if a machine is operating correctly or see the status of several similar devices.

Enter the number of places to the 
right of the decimal point to display.

Enter a label for the gauge.

Enter Engineering units (for 
example, degrees, GPM, PSI).

Change background color 
for gauge. 

Select a horizontal or 
vertical gauge.

Choose Custom to override 
the default tic marks. 
See descriptions on the 
following page..

Range 
color

Major tic

Label

Value
Units

Minor tic

Enter the gauge’s 
minimum and 
maximum values.

Choose to show the value as a 
value, a percent, or not to show it.

Enter the start and end values for this 
range. These must be not more or less 
than the gauge’s Min and Max values.

Click here to add a color 
as a range indicator on 
the gauge.

Choose the range color.

Click to close editor for this range. 
To add another, click Add Range.

For the markers on the gauge:
Choose font. Default is Arial.
Make text bold, italics, or 
both. Default is neither.
Change color (click the 
rectangle and choose).

For the current value:
Choose font. Default is Arial.
Make text bold, italics, or both. 
Default is bold.
Change color (click the rectangle 
and choose).

For the label:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. 
Default is bold.
Change color (click the rectangle 
and choose).

Leave gadget size at Auto 
or choose size in page 
grid units.

NOTE: For any property with a link button, you can 
click to break the link and choose the property value 
independently for Desktop & Tablet versus Handheld 
layouts. See “Properties and Layouts” on page 60.

If the value is very large 
(for example, 50,000 
kilograms), you can scale 
the value so numbers 
are more readable.
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More on Markers

For both major and minor intervals, if you use the default (0), groov calculates the optimum number 
and spacing of tic marks to show on the range indicator. 

If the Custom intervals you enter create more than 200 tic marks (major and minor combined), 
groov overrides your entries and sets the number and spacing so markers and values are legible. 
(Your Custom entries still appear in the Properties panel but are not used.)

Trend Gadget
Use the Trend gadget to create a trend that shows how a variable changes over time. You can 
configure up to 4 pens (variables) per trend, each with a different tag.

Trending starts in groov View when you save your changes. If a page in groov contains a Trend 
gadget that has accumulated data, when the page is opened in View, the Trend gadget is 
immediately full of data. The scanned values are retained if either groov Box or groov Server is 
restarted.

In groov View, you can download data from each pen to a .csv file, which you can open in an 
application like Microsoft Excel. See “Downloading Data from a Trend” on page 111. 

Classic or Interactive
When you configure the Trend gadget, you can choose a Classic Trend or an Interactive Trend.

Classic Trend—For simple trends with a relatively small number of data points, collected over a 
period of up to 7 days. You can hover over or touch a spot on the trend to see data for that time.

Hover or touch to see trend 
details at any point. 

Time

Trend title

Left axis

Download 
Data button

Pen legend
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Interactive Trend—For showing a large number of data points or data over a longer period (up to 
5 years). You can zoom in and out on the trend to see details. 

Hover or touch to see pen names 
and trend details at any point.

Date and time

Trend title
(For reference, 
include the 
trend period 
in the title.)

Download 
Data button 
(all data for 
the period, 
not just the 
current view)

Data navigator:
To zoom in or out on data, 
drag the handles on either side.

To keep the same zoom but see a different date/time, put your 
cursor in the center of the navigator and drag it to left or right. 

After you drag or tap, wait for the data to fill in. 

Click a tab to zoom in 
on data.
The time period of 
zoom tabs varies 
based on the Trend’s 
period.

Note that there is no room in the interactive trend for a 
pen legend. If your users view your groov interface on 
a device (such as a TV) where they cannot hover over a 
data point, use the Text Area gadget to add a legend 
next to the trend, indicating pen colors. 

Or just click or tap along the navigator line where you want to see 
the data. In this example, you might click or tap 12. April to see 
the same limited view of data around that day. This method 
works especially well on mobile devices, where a finger may not 
fit inside the zoom section. 
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Configuring Pens
You can configure up to four pens for each trend. To add and configure a pen, do the following:
1. In the Trend Properties panel, click Configure Data Sources.

For the axes:
Leave text size at Auto or choose size.
Select the axis you want to configure (left or right)
Enter the axis title. To enter a degree symbol, see Appendix D.

Choose the trend’s background color.

Enter the Period (maximum 7 days for a Classic trend, 
5 years for an Interactive trend).

Enter a title for the trend. (For an Interactive trend, you can 
include the trend period in the title for reference. )

Click here to add pens. See “Configuring Pens” below.

Enter how often you want data captured. No data is captured between 
intervals. A red text box indicates that you have entered a value less than 
the minimum. The minimum varies based on the Period you entered. 

Choose Custom to set the Minimum and Maximum values that 
make sense for the configured tag (pen). Auto sets these values for 
you; in View the trend will zoom in or out to accommodate the 
real-time range of the pen. Also see “Configuring Value Limits and 
Min/Max Values” on page 111.

For the markers:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

For the trend title:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 60.

Trend Gadget

Choose the type of trend (see “Classic or Interactive” on page 108).

Classic trends: A longer Update Interval uses less memory and may give 
better performance on a cell phone. Recommended interval is for a PC.



CHAPTER 4: GADGET REFERENCE

groov Build and View User’s Guide 111111

2. For the first pen, select a tag, enter a title, and choose either Left or Right axis, depending on 
where you want the axis located for this pen. Multiple pens can use the same axis.

3. Choose the line type, color, and whether you want to use a fill.
4. For each additional pen, click Add Pen and configure it as desired.
5. Click Done.

Z-Order. The pens are displayed in the order you configure them here. The first pen configured will 
be on the bottom of the z-order, and the last one will be on top. If you need to change the z-order, 
the quickest way is to change the tags configured for each pen. For example, if you want the bottom 
pen’s tag to appear on top, re-configure the top pen with that tag and move the other tag to the 
bottom pen.

Configuring Value Limits and Min/Max Values
The Minimum Value and Maximum Value change automatically even when Value Limits is set to 
Custom, because groov automatically adjusts the actual scaling lines and labels for optimum 
readability. For example, they may change when you do any of the following:

• Change the size of the gadget in Build

• Adjust the size of your browser in either Build or View

• Switch from Build to View

• Change the Minimum or Maximum values on the other axis

Downloading Data from a Trend
You can download the data from any pen to a .csv file, which can be used by other applications or 
opened in an application like Microsoft Excel. The file consists of a Java/JavaScript timestamp and a 
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value for each data update (determined by the trend’s update interval) during the period of the 
trend. 

For example, if you have a classic trend with a period of 24 hours and an update interval of 60 
seconds, the data you download will be for the latest 24 hours and show a data value for each 
60-second interval.

If you have an interactive trend with a period of 1 year and an update interval of 60 seconds, the 
data you download will be for the latest year and show a data value for each 60-second interval (a 
lot of data!). When downloading data from an interactive trend, remember:

• The download includes all data for the trend’s period, not just the time period you’re viewing.

• Data is for one pen only.

To download trend data: 

1. In groov View, click the Download Data button in the upper-right corner of the trend and 
choose the pen you want. 

2. When the file has been downloaded, save it in the location you want. 

If you open the file in Excel, it looks something like this:

3. The value in the Timestamp column isn’t really a date and time; it’s actually just a number of 
seconds. You can use Excel to convert it to a number that Excel can then format into a date and 
time.
a. For each row of data, copy and paste the following formula to an unused column in the 

spreadsheet. This formula converts the seconds into a (UTC time zone) date and time.
=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400

(Optional) To convert the UTC time to local time, add or subtract the number of hours that 
your time varies from UTC. For example, if your time zone is 10 hours ahead of UTC, you can 
use either of these formulas:
=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400 + (10/24)
=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400 + TIME(10,0,0)
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b. Then, use Excel’s Format Cells feature to format the resulting number as a date value, 
according to the way you’d like to see it displayed.



TREND GADGET

groov Build and View User’s Guide114



groov Build and View User’s Guide 115115

Chapter 2

5: Using Events and 
Notifications

Use this chapter to set up event conditions in groov and view event logs. All events are logged, and 
authorized groov users can see them at any time from groov View or groov Build. 

Also use this chapter to set up optional email or text notifications when an event occurs. For 
example, if a machine’s temperature is critical, you can create an event and notify a maintenance 
technician via email or text message when the machine overheats. The technician can click a link in 
the notification taking him to the groov screen with more data on the machine. 

You can customize messages, send them to groups or individuals, and include time/date stamps 
and other information. A notification can be sent when the event becomes active, inactive, or both. 

In this chapter:
Creating Events...................................................................................................................... 116
Viewing Events ...................................................................................................................... 119
Setting Up Notifications .................................................................................................... 121
Event Condition Types Reference.................................................................................. 127
Using Multiple Conditions................................................................................................ 129

Events and Notifications

Control system

All data via Modbus/TCP, OPC UA server, and 
SNAP PAC controllers is available for logging 
events and sending notifications

groov Box or 
groov Server 
for Windows

Tank level
If Full

If Empty

Boiler Temperature
If Too Hot! Text me

Email me

Email me
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Creating Events
You can create events based on one or more conditions. 
1. In groov Build, select Configure > Events.

2. Click Create Event.

3. In Event Properties, give the event a name.
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4. In Event Conditions, follow steps below to create one or more conditions that define the event. 

(For help in understanding the conditions and the fields to complete, click the Info icon .)

a. Tag—Click None Selected. In the Select Condition Tag dialog box, browse to a tag to 
monitor for this condition. If the tag is an array, also enter the array index. Then 
double-click the tag or click Select Tag.
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b. Condition—Click the drop-down menu and choose the condition type for the event. 

c. Complete additional fields as needed for the tag type and condition type you chose. 
For example, for analog or numeric tags you enter a comparison value. For Above Limit, 
you enter the limit and choose whether the event should occur when the value is greater 
than the limit, or greater than or equal to the limit. In some cases you may also want to 
enter hysteresis values or debounce times. For more information, see “Event Condition 
Types Reference” on page 127.

d. When you’ve completed the fields, click Add New Condition to save your entries. The new 
condition appears at the right (or below on a smaller screen). 

NOTE: Be sure to click Add New Condition. If no conditions appear, you’ll receive an error message 
when you try to save the event. 

e. If you want the event to depend on additional conditions, choose another tag, complete 
the fields for it, and then click Add New Condition again. 

f. If the event depends on more than one condition, complete the “This event is active 
when...” sentence. Choose All if all of the conditions must be true to trigger the event. 
Choose Any if only one of them needs to be true to trigger the event. Also see “Using 
Multiple Conditions” on page 129.

5. (Optional) To show a custom message in the event log, scroll down to Notification Messages.

The event message you will see in the log (and in an email or text notification, if you send one) 
contains default text to identify the event. Default text includes the event name, date/time, and 
whether the event began or ended. You can enter a custom message in this section if you wish. 

6. Click Create Event to save the new event. Click Close to return to the main workspace.

As soon as you save an event it is enabled, so if the event conditions become true it will be logged. 
groov continually scans for the event tags and monitors for event conditions even if groov View is 
closed. Click the events icon  in the upper-right corner of groov to view event status. Also see 
“Viewing Events” on page 119.

For details on conditions, see “Event Condition 
Types Reference” on page 127.

New conditions
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Enabling and Disabling Events
When a configured event is enabled, the event is logged (and notifications are sent, if applicable) 
when the event conditions are met. To enable or disable an event, choose Configure > Events and 
find the event you want. Then click its Enabled/Disabled button.

Viewing Events
As soon as you create an event, it is enabled; when the event occurs, it is logged. To view, sort, and 
filter logged event messages, click the Events icon (the bell) in the top right corner of either groov 
Build or groov View.

A list of configured events appears next to a menu of viewing options.

To see the status of all events, choose Current Status. You see a list of configured events and 
whether they are active (meaning that the event conditions have been met) or inactive. The text 
and indicator turn blue for events that are active; black for inactive. 

Click here

Active event
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To see a list of all logged event messages, choose Message Logs.

To sort logged event messages, click Sort By and choose Event Name, Active/Inactive, or 
Enabled/Disabled. 

To see only some events in the event message 
log, choose Filters and complete the fields. 
You can use one or a combination of these filters. 

• In the fields for Event Name Filter and Message 
Filter, enter a text string. 

• In the Start and End boxes for Time Range Filter, 
click in the field and select a date and time for 
each one. 

To download a text file of all logged messages, 
click Log Controls and choose Download Logs. 
You can open the text file in a text editor like Notepad 
or save the file for later viewing. 

To delete all event messages from the log, click Log Controls and choose Clear Logs. Only 
users with a security level of Admin can clear logs.

An active event is one that is enabled and is occurring right now. You 
can enable or disable events in groov Build (see page 127).
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Event Message Log Capacity
groov checks the size of the Event Message Log every 30 minutes. If it is more than 200 MB (typically 
over a million entries), the oldest 25% of entries are trimmed. If this occurs, a message is posted to 
the Log Viewer noting that the oldest entries have been removed. For more on the Log Viewer, see 
“Viewing Log Messages” on page 79.

Setting Up Notifications
You can choose to notify one or more authorized groov users when an event occurs, at the 
beginning of the event, the end of the event, or both. These steps assume you have already created 
the event (if not, see “Creating Events” on page 116).

Follow these steps to set up notifications:
1. Set Up the groov Email Account............................................................................... 121
2. Set Up groov Users To Receive Event Notifications .......................................... 123
3. Add Notifications to Events ......................................................................................... 125

1. Set Up the groov Email Account
This section sets up the account that groov will use to send email and text notifications. If you want 
groov to send from a Gmail account, use the setup instructions on page 122 instead.
1. Create an email account that’s just used for this groov.

A separate email account makes it clear where the email is coming from, and it provides a 
record of all successfully sent notifications in the Sent Mail folder of the groov account. 
(Currently, groov does not buffer notifications that failed to send.) 

Also, by creating a separate account for groov, you can make email setting changes and not 
impact your business or personal email account settings.

2. In groov Build, choose Configure > Project.

3. In the Email Settings window, set up the groov email account as follows:

SMTP server hostname—Enter the SMTP server address.
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SMTP server port—Consider the following:

– The SMTP port is a number between 1 and 65535. Common ports are 25 and 587 for mail 
servers using STARTTLS or no connection security, and 465 for those using SSL. 

– If you are outside a company network, you may need to try port 587. Other email servers 
might need different port numbers. Check with your IT group if you are using a company 
email server to send the emails.

Connection security—Choose STARTTLS if you are using a large service such as Yahoo. Other 
email servers may need a different setting.

Allow unstrusted certificates—Check this if your internal mail server uses a self-signed 
certificate.

Sender address—Enter the email address of the groov account you created previously. Some 
services might ignore this.

Username—Enter the username for the groov email account.

Password—Enter the password associated with the groov email account.

Send a test email—Enter an email address that can receive a test email and that you can 
easily check.

4. Click Send Test Email to test your connection settings

If a message in green letters appears that says , make sure it arrived 
the inbox of the email account you sent the message to. If you see a red error message, try 
different settings in the groov email account.

5. Scroll to the top and click Save Settings, then click Close.

Continue with step 2 on page 123.

Setting Up the groov Email Account Using Gmail

Follow these steps if you are using Gmail for the account groov sends email from. If you are using an 
email service other than Gmail, see the more general guidelines starting on page 121.
1. Create a Gmail account that’s just used for this groov.

A separate email account makes it clear where the email is coming from, and it provides a 
record of all sent notifications in the Sent Mail folder of the groov account. The Sent Mail folder 
thus functions as a kind of automatic cloud-based log file. Also, by creating a separate account 
for groov, you can make email setting changes and not impact your company or personal email 
account settings.

2. Make sure to enable the account to send email by what Google calls “less secure apps.” 

Follow these steps:

a. Open a new incognito window in Chrome, or a private window in Firefox.
b. Go to the following link:

https://www.google.com/settings/security/lesssecureapps
c. Log in to the Gmail account you created for groov. 
d. Next to “Access for less secure apps,” select “Turn on.”

https://www.google.com/settings/security/lesssecureapps
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3. In groov Build, select Configure > Project.

4. In the Email Settings window, set up the groov email account as follows:

SMTP server hostname—Enter smtp.googlemail.com.

SMTP server port—Consider the following:

– The SMTP port is a number between 1 and 65535. Common ports are 25 and 587 for mail 
servers using STARTTLS or no connection security, and 465 for those using SSL. 

– If you are inside a company network, you probably need port 25.

– If you are outside a company network, you may need to try port 587.

Connection security—Choose STARTTLS.

Allow unstrusted certificates—Make sure this option is not selected.

Sender address—Enter the Gmail address of the groov account you created previously. 

Username—Enter the Gmail address, the same as the Sender address. 

Password—Enter the password associated with the groov Gmail account.

Send a test email—Enter an email address that can receive a test email and that you can 
easily check.

5. Click Send Test Email to test your connection settings

If a message in green letters appears that says , make sure it arrived 
the inbox of the email account you sent the message to. If you see a red error message, try a 
different SMTP server port setting.

6. Scroll to the top and click Save Settings, then click Close.

2. Set Up groov Users To Receive Event Notifications
This section sets up email addresses for all groov users who should receive event notifications, either 
as email or text messages.

Text message notifications are valuable when cell coverage is weak and you’re only able to receive 
phone calls and plain text messages (SMS); even when your email client can’t update you’ll still get 
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important notifications. SMS messages are generally limited to 160 characters, but limits vary by 
carrier and country, so check with your local carrier.
1. In groov Build, choose Configure > Accounts. Then click the Users tab.
2. Highlight the user’s name and click Edit User.

3. Enter one of the following for the Email Address:

– For email notifications, enter a valid email address. For example TAtasco@foomail.com

– For text message notifications, enter the user’s phone number followed by the domain 
used by the carrier to send text messages to phones. For example, to send a text message 
to a Verizon phone, use the recipient’s mobile phone number followed by “@vtext.com”. If 
the phone number is 555-123-4567, you type 5551234567@vtext.com
For a list of carriers and email addresses, see the next section, “Email Addresses for Text 
Messaging.”

NOTE: if you want the same person to get both email and text message notifications, you will need to 
create two user accounts.

4. Click OK, then click Close.
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Email Addresses for Text Messaging

By using an email-to-SMS (Short Message Service) email address you can send a text message 
notification from groov. Check with your carrier for SMS character limits.

Here is a list of common cell phone carriers in the U.S. and Canada and the email-to-SMS email 
addresses they use for sending text messages via email to a cell phone. Choose the carrier for the 
phone you want to receive event notifications.

For carriers not listed here, see the following websites:

http://martinfitzpatrick.name/list-of-email-to-sms-gateways/

http://www.emailtextmessages.com/

3. Add Notifications to Events
1. In groov Build, choose Configure > Events.
2. Click the name of the event you want to send a notification for.
3. Scroll down to Notification Recipients.

a. Check the boxes to send the email when the event begins, when it ends, or both.
b. Do one of the following:

– Select “Send to every user with an assigned email address.” The To: list is ignored.

– In the textbox next to To, click to select users that you want to be notified.

All recipients must have an email address configured to receive event notifications. You can 
add users who don’t have email addresses, but they’ll only receive notifications when 

Carrier  Email-to-SMS Email Address

AT&T 10digitphonenumber@txt.att.net

Comcast 10digitphonenumber@comcastpcs.textmsg.com

MCI 10digitphonenumber@pagemci.com

Nextel 10digitphonenumber@messaging.nextel.com

Qwest 10digitphonenumber@qwestmp.com

Sprint 10digitphonenumber@messaging.sprintpcs.com

T-Mobile 10digitphonenumber@tmomail.net

US Cellular 10digitphonenumber@email.uscc.net 

Verizon 10digitphonenumber@vtext.com

http://martinfitzpatrick.name/list-of-email-to-sms-gateways/
http://www.emailtextmessages.com/
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addresses have been assigned. To assign and edit user email addresses, choose Configure > 
Accounts > Create/Edit User (see page 123).

TIP: If you have configured a group, you can add the group to your list, and all the users in that group 
will receive the notification.

4. Customize your message in the Notification Messages window. If you leave the subject line or 
message empty, a default subject line or message will be used.

You can add Condition Tags, Project Tags, or a Time stamp to a message. When you add a 
Condition Tag or a Project Tag to a message, the < Tag Name > placeholder will be replaced in 
the email by the tag’s value at the time of the event beginning or end.

Condition Tags—The tags that you have referenced in the conditions for this event. When 
using condition tags, if you alter the conditions for this event, make sure that your tag 
references in these messages are updated to match.

Project Tags—All of the device tags in this groov project.

Time stamps—All < Time-stamp > placeholders are replaced in the email by the current local 
time of the event beginning or ending.

– In groov Server for Windows, the time stamp uses the local time that the PC is set to.

– On a groov Box, make sure your time zone is correctly set in groov Admin. By default, the 
groov Box is set to UTC. If you change the time zone in groov Admin, you must restart the 
groov Box for the change to propagate through all of groov. Once restarted, event time 
stamps use the configured time zone. For more information, see “Changing the Time Zone” 
in form 2104, the groov Box User’s Guide for GROOV-AR1 or form 2077, the groov Box User’s 
Guide for GROOV-AT1.

5. Scroll back up to the top of the window and click Update Event. Then click Close to return to 
groov Build. 

Condition Tags Project Tags Time-stamp

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4382
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Once you save or update an event it becomes active, so if the event conditions become true a 
notification will be sent to groov View even while you are in Build. groov continually scans for the 
event tags and monitors for event conditions even if groov View is closed. Click the events icon  
in the upper-right corner of groov to view event status. Also see “Viewing Events” on page 119.

Event Condition Types Reference
Use the information in this section when creating events (page 116). If you want to use multiple 
conditions, also see “Using Multiple Conditions” on page 129.

Not Equal
The event is active when the tag value is not equal to the Comparison Value. The event is inactive 
when the tag value is equal to the Comparison Value.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value 
must satisfy the condition before the event becomes active or inactive. If in that time the tag returns 
to a value that does not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Equal
The event is active when the tag value is equal to the Comparison value. The event is inactive when 
the tag value is not equal to Comparison Value.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value 
must satisfy the condition before the event becomes active or inactive. If in that time the tag returns 
to a value that does not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Above Limit
The event is active when the tag value is greater than (or equal to) the Limit value. To become 
inactive, the tag value must drop to the Limit minus the hysteresis offset or below.

Hysteresis. A hysteresis offset value is used to determine when an active event may be 
considered inactive. It establishes an offset from the condition limit that the tag must reach before 
the event may transition from an active state to inactive.

For Above Limit conditions with hysteresis, the tag value must drop below the Limit value minus the 
hysteresis offset. For example, if you want to know if a boiler's temperature exceeds a safe limit of 
200 degrees, you could create an Above Limit condition that monitors the tag assigned to the boiler 
temperature sensor.
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Setting the Limit Value to 200 and a Hysteresis to 20 indicates that if the boiler temperature exceeds 
200 degrees, it should not be considered safe/stable until the temperature drops to 180 degrees or 
below, rather than the maximum 200 degree limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value 
must satisfy the condition before the event becomes active or inactive. If in that time the tag returns 
to a value that does not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Below Limit
The event is active when the tag value is less than (or equal to) the Limit value. To become inactive, 
the tag value must rise up to the Limit plus the hysteresis offset or above.

Hysteresis. A hysteresis offset value is used to determine when an active event becomes inactive. 
It establishes an offset from the condition limit that the tag must reach before the event changes 
from an active state to inactive.

For Below Limit conditions with hysteresis, the tag value must rise above the Limit value plus the 
hysteresis offset. For example, if you want to monitor a settling pond to determine when it is below 
capacity and is ready to receive more water, you could create a Below Limit condition that monitors 
the tag assigned to a water level sensor.

Setting the Limit Value to 4 (meters) and a Hysteresis of 2 indicates that if the pond drops below 4 
meters in depth, it should not be considered to be at capacity until the level reaches 6 meters or 
greater, rather than the minimum 4 meter limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value 
must satisfy the condition before the event becomes active or inactive. If in that time the tag returns 
to a value that does not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Outside Range
The event is active when the tag value is less than (or equal to) the Lower limit or greater than (or 
equal to) the Upper Limit. To become inactive, the tag value must rise up to or above the Lower 
Limit plus the Lower Hysteresis, or drop to or below the Upper Limit minus the Upper Hysteresis.

The hysteresis values are used to determine when an active event tag becomes inactive. They 
establish a value range that the tag must reach before the event changes from an active state to 
inactive. The Upper Hysteresis and Lower Hysteresis are independent of each other and either one 
may be left blank.

Also, for an Outside Range condition, hysteresis must be less than the difference between the Upper 
Limit and Lower Limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value 
must satisfy the condition before the event becomes active or inactive. If in that time the tag returns 
to a value that does not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.
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Inside Range
The event is active when the tag value is between the Lower and Upper limits. To become inactive, 
the tag value must drop to or below the Lower Limit minus the Lower Hysteresis, or rise up to or 
above the Upper Limit plus the Upper Hysteresis.

The hysteresis values are used to determine when an active event tag becomes inactive. They 
establish a value range that the tag must reach before the event changes from an active state to 
inactive. The Upper Hysteresis and Lower Hysteresis are independent of each other and either one 
may be left blank.

Using Multiple Conditions
Using multiple conditions for a single event is a good way to reduce event duplication and to 
capture events that depend on the state of multiple tags. When using more than one condition for 
an event, the “event is active when” statement has the following effect:

Any: The event is active when condition 1 is active OR condition 2 is active OR condition 3 and so 
on. The event becomes inactive only when ALL of the conditions are inactive.

Example uses:

• You have multiple tags that all monitor the same type of condition.

• You want to be notified of a problem in your process that could be caused by any one of a 
number of sub processes.

All: The event is active when condition 1 is active AND condition 2 is active AND condition 3 and so 
on. The event becomes inactive when ANY of the conditions is inactive.

Example uses:

• Multiple components along a process line turn off sequentially when not in use. It is normal to 
have some components off at any given time. If all of the components are off at the same time, 
however, that may indicate a problem.

• You have a system monitoring multiple boilers. If any one of those boilers becomes too hot, a 
separate, per-boiler event notification is sent to your onsite technicians. If several boilers all 
become too hot at the same time, a notification is sent to your on-call technicians and your 
engineers.
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Chapter 3

6: Viewing Your Operator 
Interface

The operator interface developed in groov Build can be accessed using groov View in a computer’s 
browser, and in a smartphone, tablet, or other mobile device that has the groov View mobile app or 
a modern browser.

In this chapter:
Opening View................................................................................... 131
Opening a Page............................................................................... 132
Logging Out...................................................................................... 132
Changing Your Password............................................................. 133
Refreshing the Operator Interface .......................................... 133
Automatic Refresh.......................................................................... 134
Setting Up groov Mobile Apps................................................. 134
Using groov over the Internet................................................... 143

Opening View
1. Open your web browser or mobile device app (groov View for iOS or groov View for Android). 

These steps are for a web browser. For the app, see “Setting Up groov Mobile Apps” on 
page 134.

For groov Server:

– If groov Server is installed on the same computer, type https://localhost in the 
address bar of your browser.

– If groov Server is installed on a different computer, type https:// and the computer’s 
hostname. For example, if the computer’s hostname is RStarr-w7, you type 
https://RStarr-w7

You can use the IP address of the host PC instead of the hostname. However, if the PC is on 
a network with DNS and DHCP, the IP address is subject to change.

Make sure you type the s: https://

For groov Box:

Type https:// and the groov Box’s hostname or IP address as the URL. The hostname is printed 
on the bottom of the groov Box. (Your hostname will be different from this example.)
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For example, if the hostname is opto-00-d2-dc, you type https://opto-00-d2-dc,

Make sure you type https. The s indicates it is a secure connection.

NOTE: If you’ve assigned a static IP address to the groov Box, use the IP address instead of the 
hostname to open groov.

2. Log in with your username and password.

Opening a Page
1. Click the navigation icon in the upper left of the screen.

2. Expand the page’s category.
3. Click the link.

Logging Out
1. Click the gear icon on the top right-hand side.

Hostname

Icon

Category

Link
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2. Click Log out ‘Username’.

The login dialog box appears.

Changing Your Password
1. Click the gear icon on the top right-hand side and choose Change Password.

2. Enter the current password and the new password (twice).

3. Click Change Password.

Refreshing the Operator Interface
If changes have been made and saved in groov Build, you can refresh View at any time and the new 
changes will appear.
1. Click the gear icon on the top right-hand side.
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2. Click Refresh groov View.

Automatic Refresh
Starting with version R3.2a, when your groov version is updated (for example, from R3.2a to R3.2b), 
clients will also be automatically updated. 

Different browsers may handle the refresh differently: some may simply refresh, but others may 
show a dialog box that requires the user to acknowledge the change. Since browsers constantly 
change, we can’t know for certain which browsers will require a response. 

If you have kiosk users, be aware that you may need to respond on the kiosk device when you 
update your version of groov. 

Setting Up groov Mobile Apps
Opto 22’s free groov View apps for iOS and Android are the best way to view your operator interfaces 
on your iPhone, iPad, or Android smartphone or tablet. In the app you can see one or more groovs in 
full-screen mode without the address bar, toolbars, and other things you see in a browser. 

To connect to groov the first time:
1. Download the app: 

– groov View for iOS

– groov View for Android
2. Install the app on your iOS or Android device.
3. Tap the groov icon to start the app.

Continue with the instructions for iOS or Android:

“Using the iOS Mobile App” (below)

“Using the Android App” on page 139

Using the iOS Mobile App

In this section:

“Adding a groov to the iOS App”

“Connecting, Editing, and Setting a groov as the Default Using the iOS App”

“Using the iOS App Settings”

https://itunes.apple.com/us/app/groov-view-for-ios/id639797810?mt=8
https://play.google.com/store/apps/details?id=com.opto22.aWD


CHAPTER 6: VIEWING YOUR OPERATOR INTERFACE

groov Build and View User’s Guide 135135

“Navigating groov with the iOS App”

Adding a groov to the iOS App

Follow these steps in your iOS app to connect to groov the first time or whenever you want to add 
another groov connection.
1. Tap the groov icon to open a list view for adding one or more connections.

2. Tap  to open the configurator. 

3. Enter the following information. (Tap on the screen outside of the text boxes to hide the 
keyboard and reveal any hidden options.)

– Hostname—Type https:// and groov’s hostname or IP address.

NOTE: If you are within the company network and have a valid hostname that is registered with 
the domain server, you still might have to type the fully qualified domain name. For example, if 
the hostname is “Petrovsgroov” and the domain name is “somecompany.com”, you would type 
“Petrovsgroov.somecompany.com”.

– Display Name—Create a name that will appear in the connection list.

– Port—Enter the port number, usually 443.
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– Username and Password—Enter the username and password for this connection.

– Full Screen—Enable this option to hide navigation to the groov list. (With this option 
enabled, swipe right to go back to the groov list.)

– Passcode—When enabled, the next time you connect to this groov, you will be prompted 
to enter a new passcode which will then be needed each time you attempt to view this 
connection.

– Handheld Layout (iPad only)—Enable this option to force the display to use groov’s 
handheld layout rather than the desktop layout.

4. Tap Done.

Connecting, Editing, and Setting a groov as the Default Using the iOS App
Follow these steps in your iOS app to connect to groov, edit the configuration settings, or set a 
default connection.
1. Start the groov app to open a list of connections.

If you haven’t connected a groov, see “Adding a groov to the iOS App.” If you have set and 
enabled a default connection, groov View automatically attempts to connect to the default 
groov connection. To return to the list view, swipe right.

2. Tap a connection in the list to open its groov Options.

– Connect—Connects to the selected connection.

– Edit—Opens the configurator for the selected connection for you to edit the connection 
settings. The configurator screen is filled with the data from the selected connection, and 
the title is the Display name (if configured) or the hostname of the connection. For 
information about the options, see “Adding a groov to the iOS App.”
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– Set as Default—Sets the selected groov connection as the default so that when you start 
the groov View app it bypasses the connection list and opens the default connection 
automatically. For this to work, also turn on Enable Default Connection in the app settings. 
See “Using the iOS Mobile App Settings.” The default connection is indicated with a check 
mark. Only one connection can be the default.

– Delete—Deletes the selected connection from the list.

– Cancel—Exits groov Options.

Using the iOS Mobile App Settings

To configure the iOS groov app settings, tap the gear icon.

• Hide Status Bar—Hides the status bar that normally appears at the top of the screen.

• Connection Timeout—Set how long the app will spend trying to connect to the groov 
connection. The timer starts as soon as the Connect menu option is selected.

Default connection

Tap the 
gear icon
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• Enable Default Connection—Use this option if you want to bypass the connection list when 
starting the groov app and go directly to the default connection. You will also need to assign a 
default connection in the groov Options. See “Connecting, Editing, and Setting a groov as the 
Default Using the iOS App.”

• Lock Settings—When enabled, no connections can be added, modified, or deleted, and the 
settings themselves can’t be changed. When using this option you’ll also want to require a 
passcode. Otherwise, anyone can unlock the settings.

• Require Passcode—When enabled, the user must enter a passcode to change the settings, or 
add, modify, and delete connections. You’ll be prompted to enter a new passcode when you 
enable the option.

Navigating groov with the iOS App
Use the following techniques to navigate the iOS app:

• To return to the connection list without closing the current groov connection, simply swipe 
right. This works in normal view or with Full Screen enabled (see “Adding a groov to the iOS 
App”). The active connection will be shown in green.

• To return to the current connection, do one of the following:

– Swipe left from the connection list.

– Tap the active connection and choose Resume from the menu.

• To disconnect from the current connection, tap the connection in the list, and choose 
Disconnect.

active connection
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• To navigate an external webpage that opens when you tap a URL link while viewing a groov 
connection, a navigation bar is provided at the bottom of the page. To return to groov, click the 
groov icon.

Using the Android App
In this section:

“Adding a groov to the Android App”

“Connecting, Editing, and Setting a groov as the Default Using the Android App”

“Navigating groov with the Android App”

Adding a groov to the Android App
Follow these steps in your Android app to connect to groov the first time or whenever you want to 
add another groov connection.
1. Tap the groov icon to open a list view for adding one or more groovs.

Return to groov
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2. Tap  to open the configurator.

3. Enter the following information.

– Hostname—Type https:// and groov’s hostname or IP address.

NOTE: If you are within the company network and have a valid hostname that is registered with 
the domain server, you still might have to type the fully qualified domain name. For example, if 
the hostname is “Petrovsgroov” and the domain name is “somecompany.com”, you would type 
“Petrovsgroov.somecompany.com”.

– Display Name—Create a name that will appear in the connection list.

– Port—Enter the port number, usually 443.

– Username and Password—Enter the username and password for this connection.

– Full Screen—Enable this option to hide navigation to the groov list. (With this option 
enabled, swipe right to go back to the groov list.)

– Require Passcode—When enabled, the next time you connect to this groov, you will be 
prompted to enter a new passcode which will then be needed each time you attempt to 
view this connection..

– Handheld Layout—Enable this option to force the display to use groov’s handheld layout 
rather than the desktop layout.

4. Tap OK.

Connecting, Editing, and Setting a groov as the Default Using the Android App

Follow these steps in your Android app to connect to a groov, edit the configuration settings, or set a 
default connection.
1. Start the groov app to open a list of connections.
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If you haven’t connected a groov, see “Adding a groov to the Android App.” If you have set and 
enabled a default connection, groov View automatically attempts to connect to the default 
groov connection. To return to the list view, tap the back button  or swipe right.

2. Tap a connection in the list to open its groov Options.

– Connect—Connects to the selected connection.

– Edit—Opens the configurator for the selected connection for you to edit the connection 
settings. The configurator screen is filled with the data from the selected connection, and 
the title is the Display name (if configured) or the hostname of the connection. For 
information about the options, see “Adding a groov to the Android App.”

– Set as Default—Sets the selected groov connection as the default so that when you start 
the groov View app it bypasses the connection list and opens the default connection 
automatically. For this to work, also turn on Enable Default Connection in the app settings. 
See “Using the Android Mobile App Settings.” The default connection is indicated with a 
check mark. Only one device can be the default.

– Delete—Deletes the selected groov.

– Cancel—Exits groov Options.

Default connection
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Using the Android Mobile App Settings

To configure the Android groov app settings, tap the gear icon.

• Enable Default Connection—Use this option if you want to bypass the connection list when 
starting the groov app and go directly to the default connection. You will also need to assign a 
default connection in the groov Options. See “Connecting, Editing, and Setting a groov as the 
Default Using the Android App.”

• Connection Timeout—Set how long the app will spend trying to connect to the groov 
device (called a connection). It starts as soon as the Connect menu option is selected.

• Lock Settings—When enabled, no devices can be added, modified, or deleted, and the 
settings themselves can’t be changed. When using this option you’ll also want to require a 
passcode. Otherwise, anyone can unlock the settings.

• Require Passcode—When enabled, the user must enter a passcode to change the settings, or 
add, modify, and delete devices. You’ll be prompted to enter a new passcode when you enable 
the option.

Navigating groov with the Android App

Use the following techniques to navigate the Android app:

• To return to the connection list without closing the current groov connection, simply swipe 
right. This works in normal view or with Full Screen enabled (see “Adding a groov to the 
Android App.” The active connection will be shown in green.

Tap the 
gear icon

active connection



CHAPTER 6: VIEWING YOUR OPERATOR INTERFACE

groov Build and View User’s Guide 143143

• To return to the current connection, do one of the following:

– Swipe left from the connection list.

– Tap the active connection and choose Resume from the menu.

• To disconnect from the current connection, tap the connection in the list, and choose 
Disconnect.

• To navigate an external webpage that opens when you tap a URL link while viewing a groov 
connection, a navigation bar is provided at the bottom of the page. To return to groov, click the 
groov icon.

Using groov over the Internet
If you’re using a PC or mobile device to communicate with groov over the Internet rather than from 
inside your local area network, you can use either a VPN (virtual private network) or port forwarding. 
However, a VPN is strongly recommended because it is much more secure. Talk with your IT 
Department to get a VPN set up. For more information on using a VPN and port forwarding, see 
form 2161, the Guide to Networking groov.

With a less-secure port forwarding connection, groov uses the following ports:

Return to groov

Port For communication with

443 or 8443 groov Build and groov View (443 is the default)

10000 groov Admin (applies to groov Box only)

3000 Node-RED Admin (GROOV-AR1 groov Box only)

1880 Node-RED Editor (GROOV-AR1 groov Box only)

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4537
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Chapter 4

7: Troubleshooting and 
Additional Help

This chapter provides troubleshooting information and answers questions you may have about 
groov.

In this chapter:
Troubleshooting.............................................................................. 145
Working with groov....................................................................... 152
Opto 22 Systems............................................................................. 153

Troubleshooting
In addition to the questions and answers in this chapter, see “Viewing Log Messages” on page 79. 
Admins for groov may also find it useful to create an Admin-only page to show system information, 
such as uptime, number of user sessions, CPU usage, and so on. See “Adding System Tags” on 
page 51. 

Q: In groov View on my laptop/HDTV/phone/tablet, all I see is a blank page.
What's the matter?
A: Two possibilities:

• Your web browser may not fully support the modern standards groov is based on. Try 
downloading the latest version of your browser. Or try a different browser. We generally 
recommend Firefox or Chrome, but your device might work better with Safari or Internet 
Explorer.

• You may be logged in as a user who doesn’t have access to any pages. Go to groov Build and 
check your users and groups to make sure the user has access. See “Managing User Access” on 
page 65 for help.

Q: In groov View on my mobile device, I can't get the pages to load. 
How do I get to them?
A: First, make sure you have at least the minimum OS for your device:

• Android: 4.0.1 (Ice Cream Sandwich)

• iOS: 5.0

If you’re still having problems, don’t worry. We’ve seen some quirks depending on your device and 
browser. Here are some things to try.



TROUBLESHOOTING

groov Build and View User’s Guide146

• Try adding your own company domain to the hostname of the groov Box or groov Server PC. 
Sometimes the DNS (domain name server) won’t resolve the hostname unless you add your 
domain. Example: instead of https://opto-02-81-c2 try https://opto-02-81-c2.opto22.com 
(Your domain will be different. Note the period between the hostname and domain.)

• Try adding the port number to the hostname. Port 443 is the default; port 8443 is the 
secondary, so try them in that order. For example: instead of https://opto-02-81-c2 try 
https://opto-02-81-c2:443 (Note the colon between the hostname and port.)

Q: I'm in groov View, and some of the gadgets are grayed out with a yellow triangle. 
What's going on?
A: If a gadget is grayed out with a yellow triangle, one of these communication problems is 
occurring:

• groov View isn’t communicating with the groov Box or Server.

• groov isn’t communicating with the Modbus/TCP device, PAC controller, or OPC UA server.

• The Modbus device, PAC controller, or OPC UA server is not communicating with your control 
system or equipment.

Click the yellow triangle to display an information dialog box.

If the information box says that a tag is not available on the controller, make sure the strategy 
running on that controller matches the idb.txt you have associated with that IP address.

Once you’ve fixed communications, groov View will automatically restore the gadget to working 
order.

NOTE: The groov Box or groov Server polls the controller, OPC UA server, or Modbus device for data once per 
second. This frequency cannot currently be changed.

Q: In groov View, some of the gadgets are grayed out with a manilla tag. 
What does this mean?
A: If a gadget is grayed out with a no-tag symbol, the gadget does not have a properly configured 
tag associated with it.

Once you’ve configured a tag for the gadget, groov View will automatically restore the gadget to 
working order.

Q: I am not receiving event notifications for properly configured events.
What’s wrong?
A: You may have lost connection with your Modbus/TCP device, PAC controller, or OPC UA server. If 
so, groov can’t check the tags it’s supposed to be watching, so you won’t receive event notifications 
for those tags.

Click the yellow 
triangle

No-tag symbol
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Click the Events (bell) icon to open the Events Viewer. If you see the “Could not connect...” error, 
you’ll need to track down what happened to your lost connection. Also see “Viewing Events” on 
page 119.

Q: In groov Build, I can’t see the dialog box buttons. 
How do I make them visible?
A: If you can’t see dialog box buttons, your browser’s font size may be set too high. Reduce the 
browser’s font size so that you can see them.

Q: I have groov Server and I’m not able to open groov. What should I do?
A: There might be a conflict with another service running on your computer. In this case, you might 
need to change one or both of the ports groov Server uses to run.

To change a port number, first consult with your IT manager, and then do the following:
1. Open the jetty.conf file installed on the groov Server computer. You’ll find the file in 

Opto22\groov\jetty.

2. Change the port as necessary.
3. Save and close the file.
4. Restart groov Server and try again.

To restart groov Server:
5. Open the Windows Control Panel and click Administrative Services.
6. Select groov Server.
7. Click Restart.
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Q: I have a groov Box and a Windows computer, and I’m not able to locate my 
groov Box on the network. What should I do?
A: If you are using a Windows computer, you can use groov Find to locate the groov Boxes on your 
network. You must use groov Find if your network does not have DNS.
1. Insert the groov CD in your CD-ROM drive, then click the link to copy the Find application file to 

your computer.
2. Open the Find application file.

If you have User Account Control (UAC) turned on, a message appears asking if you want Find 
to be allowed to make changes to your computer. Click Yes.

NOTE 1: If you are using a Windows account that does not have Administrator privileges (such as 
Guest), you will need to enter the Administrator User Name and Password in order to use groov Find. 
If you do not have this information, contact your IT department.

NOTE 2: Clicking Yes permits Find to have temporary administrative privileges to create an additional 
temporary IP address for each network interface on the computer. This enables Find to locate a groov 
Box on a network that does not have DNS and DHCP. If the network does not have DNS and DHCP, you 
will need to assign a static IP address to the groov Box in order to maintain communication. (See the 
groov Box User’s Guide.) If the network does have DNS and DHCP, the temporary IP address is not used 
and is removed when you exit Find.

groov Find opens and automatically searches for groov Boxes on the network.

3. Find the serial number on the bottom of the groov Box.

Click Restart
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4. Locate the matching serial number in Find.

If you do not see the serial number right away, wait 60 seconds and click Search for Devices.

5. Click the link “Click to start groov.”

Q: I’m having trouble using Internet Explorer 10 with groov. 
What should I do?
A: You can try Chrome or Firefox instead if those browsers are available. But if you want to use 
Internet Explorer 10, do the following steps to make sure the browser is not reverting back to version 
9 mode; groov is not compatible with Internet Explorer 9.
1. Open Internet Explorer 10.
2. If the menu bar is not already showing, right-click anywhere in the top border of the browser 

and select the Menu bar option.

Serial number

LinkSerial number
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3. Open the Tools menu, and make sure that Compatibility View is not selected.

4. Select Tools > Compatibility View settings.
5. In the Compatibility View Settings dialog box, make sure that no groov IP addresses or 

hostnames are listed under “Websites you’ve added to Compatibility View.” 
6. Also, make sure that the compatibility options at the bottom of the dialog box are not checked.

Make sure this option is 
not selected.

Make sure these 
options are not 
checked.

Make sure no groov IP 
addresses or hostnames 
are listed.
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7. Click Close

Q: My cell phone disconnects from groov after about 30 seconds. 
What should I do?
A: The settings on your phone can cause a connection to the soft access point on the groov AR1 to 
disconnect.

If you are a Sprint customer: Try turning off the Connections Optimizer. On your phone, go to 
Settings > More... > Mobile Networks > Connections Optimizer and uncheck the box for this feature.

If you are not a Sprint customer: On your phone, go to Settings > Wifi > Advanced and make sure 
that the “Avoid poor Internet connection” and “Internet Unavailable” options are unchecked.

Q: I can’t read (or write to) my Modbus/TCP device OR the data I get from my 
Modbus/TCP device doesn’t make sense. What’s wrong?
A: Modbus/TCP devices, though based on a standard protocol, may be set up differently from one 
another. Some use zero-based addressing and some use one-based addressing. Some devices don’t 
support all Modbus functions. Modbus/TCP devices also vary in the way they present float data. And 
device documentation sometimes doesn’t specify how the device is set up.

If you’re having trouble reading or writing to your device, or if the data is clearly wrong, start by 
reading the sections “Modbus Protocol Settings” and “Data Interpretation Settings” on page 34. 
Consult your device’s documentation for help, and change the settings for your Modbus device in 
Configure > Devices and Tags. You may need to try different combinations of settings to see what 
works. 

If data from the Modbus device doesn’t make any sense (looks like garbage or is completely 
abnormal), change the “Use base one addressing” setting. Or change the combination of Data 
Interpretation Settings. 

Probably the best way to figure out how to connect with any Modbus/TCP device and get the data 
presented in the right format is to use a Modbus/TCP test utility, like ModScan32 from 
www.Win-Tech.com. Our Product Support Group recommends this utility.

You can also use the utility Wireshark (www.wireshark.org) to see the Modbus/TCP traffic between 
your devices, so you know exactly what message was sent and what the specific reply was. 

If you need help, be sure to contact Opto 22 Product Support (see page 8). Product support is free.

Q: I want to check when my license expires or renew my license, but I don’t 
see the Licensing item in the Configure menu. Why not?
A. You must be logged into groov Build as an Admin security level user in order to see licensing 
information or update your license. If you’re logged in as an Editor, you won’t see Licensing in the 
Configure menu.

NOTE: If you’re using a groov Box, it’s easy to confuse groov Admin, the software that administers the Box, 
with the Admin user security level in groov Build. What you need for licensing is the Admin username and 
password for groov Build. 

Q: Is there a forum for groov? 
A: Yes! There's a groov OptoForum. Find it at www.opto22.com: click Community > OptoForum > 
groov. This is the place to ask and answer questions about groov. Experienced engineers and 
integrators all over the world contribute to OptoForums, so it's a great way to get help at any time.

http://www.win-tech.com/html/modscan32.htm
http://www.wireshark.org
http://www.opto22.com/community/forumdisplay.php?f=13
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Working with groov
Q: How safe is groov in terms of information security?
A: groov uses the same security as your bank: the latest 256-bit encryption, plus authentication with 
usernames and passwords. For communications over the Internet, we recommend a virtual private 
network (VPN).

Q: Can I VPN directly into my groov Box?
A: No, the groov Box is not a VPN server, which is required if you want to use VPN to communicate 
with groov. Find out if your company network has a VPN server. Many do, usually to let employees 
safely access the network from home or a remote site. Most smartphones have a VPN client built 
into them. For more information, see form 2161, the Guide to Networking groov.

Q: How often does the groov operator interface update the data from my 
control system?
A: Your interface in groov View polls the Modbus/TCP device, PAC controller, or OPC UA server once 
per second, so you'll see the live data updated every second. Currently you can't change this rate.

Q: Why are there two passwords for the groov Box?
A: When you first set up the groov Box, you have to enter two username and password 
combinations. That’s because they’re for two separate purposes:

• One is for administering the groov Box using groov Admin. Here you do things like change 
network settings or check the status of the Box.

• The other is for building and viewing your operator interfaces using groov Build and groov View. 
Here you’ll also set up usernames and passwords for the other people in your company who 
will be using groov.

For system security, it’s extremely important that you guard these login credentials carefully. Treat 
them as if they were passwords for your bank account. And don’t lose them. Since they cannot be 
retrieved, you will lose your work if you lose them.

Q: What’s the hostname?
A: The hostname is the name your network uses for a groov Box or other devices, like computers, on 
your network. The default hostname for a groov Box is on the label on the Box. The default 
hostname for a groov Server PC is the name of the PC on the network.

To get to groov, you type https:// and the hostname in your web browser.

Example: If the hostname on a groov Box label is opto-02-2b-a6, you open a browser and type: 
https://opto-02-2b-a6

Example: If the hostname of the PC where groov Server is installed is win8-server, you open a 
browser and type: https://win8-server

Notice that you have to type https, not just http. The “s” indicates it’s a secure connection.

You can change the hostname from the default to whatever you want to use. See “Editing a Device’s 
Address” on page 56.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4537
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Q: Can I change more than one tag with a single gadget, or stack gadgets to 
do two things at once?
A: Sorry, not for control. Currently groov supports only one tag per gadget. And if you stack gadgets, 
the one on top wins: it’s the only one that will be functional. 

From a monitoring standpoint, though, if indicators on the gadget at the back are still visible with 
another gadget in front, stacking gadgets can work. See Chapter 4: Gadget Reference for details on 
each gadget, including transparency (opacity) options and using images or colors to indicate values 
within a range. 

Q: Can gadgets be restricted to particular operators?
A: Operator permissions are based on a page, so everything on one page must be OK for everyone 
in a user group to see and change. If some operators should be able to see a gauge and some 
should not, for example, just create two pages—one that includes the gauge and one that doesn’t. 
Then assign user rights to the pages appropriately. See “Managing User Groups” on page 70.

A page can be different for operators using it on a desktop or tablet versus those using it on a 
handheld device, however. You can stash individual gadgets so they don’t appear in one view while 
still visible in the other. See “Using the Page Stash” on page 24. 

Q: Can you choose who can edit which pages?
A: At present anyone designated as an Editor can edit all pages on one groov. A second groov would 
give you the option to assign different Editors to different pages.

Opto 22 Systems
Q: I'm talking to Opto 22 equipment and I can't find my strategy .idb.txt file.
Where is it?
A: Your SNAP PAC controller is running the control program (strategy) you built in PAC Control. 
When you saved that strategy, the .idb.txt file was automatically created on your PC in the same 
directory as your other strategy files. If you’re now using a different PC, you’ll need to get the .idb.txt 
file from the other computer.

If your computer hides common file type extensions (some do), you’ll see two files with the same 
name, the name of your strategy. Just select the file that does not have the PAC Control icon next 
to it.

NOTE: If you’re using groov with an OptoEMU Sensor, you can get the OptoEMU Sensor.idb.txt file on 
opto22.com.

Q: What’s the minimum PAC firmware requirement for groov?
A: The SNAP PAC controller your groov connects to must be running 9.2 or newer firmware. If you’re 
using groov with an OptoEMU Sensor, you need update file R3.0a or newer.

Q: How do I set up groov on my network so it connects to my SNAP PAC 
controller? 
A: Take a look at the Guide to Networking Opto 22 Products. This guide gives you details on how to 
connect groov with SNAP PACs inside your facility on the same network or on separate networks, 
and also how to connect over the Internet.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4401
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Q: If a PAC controller is connected to B3000 serial brains, can I get those tags 
in groov?
A: Yes. If the tag is in the controller, it can be displayed in groov.

Q: Can I use groov with my FactoryFloor system? I have an Ethernet card.
A: Yes, but not directly. groov works with all SNAP PACs running 9.2 firmware or higher (SNAP PAC 
S-series controllers, SNAP PAC R-series controllers, SoftPAC software-based controller), and with 
OptoEMU Sensor energy monitoring units running update file R3.0a or newer.

groov does not work with Opto 22 FactoryFloor, SNAP Ultimate I/O, SNAP-LCSX, or other legacy 
controllers, or pre-9.2 SNAP PACs.

However, it’s still possible to use groov with these legacy systems by installing KEPServerEX with the 
OPC Connectivity Suite. Connect to your FactoryFloor OPC Server (which is an OPC-DA server). Then 
groov (which is an OPC UA client) connects to KEPServerEX, and you can import your tags.

Normally groov references the names of I/O points in a SNAP PAC controller running a PAC Control 
strategy; groov does not directly access Opto 22 brains. If you have the Kepware Opto 22 Ethernet 
OPC Server, however, you can add tags to connect directly to I/O.

Q: Can I use groov to access I/O points on my SNAP PAC brain?
A: Yes, through a SNAP PAC controller. groov does not access the brain directly; it works through a 
SNAP PAC controller running a PAC Control strategy.

Q: Can I use tables in groov?
A: You can select individual elements (indices) of a table. groov supports all of these data types: 
integer, float, and string variables and tables, and analog and digital I/O.

Q: How do I use timers/PIDs/Scratch Pad in groov?
A: groov supports integer, float, timer, and string variables and tables, and analog and digital I/O. To 
use elements in a PID loop, memory-map Scratch Pad elements, or other data you need in a groov 
interface, just periodically move the data you want into a variable. Voilá! groov can see and use it.
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Appendix A

A: IP Cameras

The Video gadget works with IP cameras that can serve a single image in response to an http 
request without the need for an ActiveX control. Make sure that the IP camera or server is configured 
to provide a single frame at a time. IP cameras serve content in a variety of ways, but single-frame 
display is a very common configuration option.

We have successfully used the following IP cameras in our projects:

• Foscam Fi8910w

• Foscam Fi9802w

• Vivotek FD8361

• Vivotek IP8352

If you are using a make or model IP camera other than ones listed here, you can try using one of the 
example URLs described in the sections below.
In this appendix:

Serving a Single Image in Response to an HTTP request.........155
Setting up the IP Camera’s Username and Password ................156
Foscam IP Cameras ....................................................................................156
Vivotek IP Cameras.....................................................................................157
Viewing a IP Camera Outside the Network.....................................157
Changing the Video Gadget Refresh Period...................................158

Serving a Single Image in Response to an HTTP request
groov does not support streaming. Instead it uses a web browser to retrieve a sequence of images 
from an IP camera. Therefore, when you set up a Video gadget you cannot simply paste the IP 
camera’s IP address (like you can in your browser). Nor can you use the link that leads to the 
IP camera video stream. Instead you need to construct a link that will retrieve a single image from 
your IP camera is. Your link will look something like this: 
http://123.123.123.123/snapshot.cgi

Every IP camera is different so you will have to look in your IP camera’s documentation to find out 
what your specific IP camera uses. It might be called either a snapshot or single shot.

TIP: To find URL information for your IP camera on the Internet, try doing a search using your IP camera 
model number and the word “snapshot.”
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Setting up the IP Camera’s Username and Password
If your IP camera requires a password, you will need to include the user name and password in the 
URL that the browser passes to the IP camera.

NOTE: Not all IP cameras use the same format, so you will need to refer to your IP camera’s documentation 
for the exact syntax. 

1. Construct the URL to include the user name and password.

For example:

http://123.123.123.123/snapshot.cgi?user=yourusername&pwd=yourpassword

Make sure to use your IP camera’s IP address and link information, and use the appropriate user 
name and password to replace yourusername and yourpassword. If you do not provide the user 
name and password in the URL, View will display an empty box instead of the image and 
prompt you for the user name and password.

NOTE: The link will not be secure because you are passing the username and password in plain text, 
so it is easy to sniff.

2. Open the URL in a new browser tab. 

You should see a static picture.

3. Try clicking Refresh or Reload in the browser.

If the static picture updates to a new picture, this means you’ve got a IP camera and a URL that 
will work with the groov app.

4. Copy and paste the URL into the video gadget, and then save the project.

In View the image is refreshed at the rate set in Configure > Project in groov Build.

NOTE: It is the browser that polls the IP camera, not the groov box. So the browser that needs to have 
network access, permissions, etc to access the IP camera, not the groov box.

If you use this procedure and cannot get the web browser to display a static image from the 
IP camera, it is not a groov issue. It is an issue with the IP camera itself or its configuration, the 
browser or browser settings, the network (e.g. not on same subnet), or network permissions. For 
more information, see “Viewing a IP Camera Outside the Network” on page 157.

Foscam IP Cameras

Foscam Fi8910w 
Sample URL:
http://123.123.123.123/snapshot.cgi?user=UUUU&pwd=PPPP

Change the IP address to match your internal or external IP address. Change UUUU to the username 
for the IP camera, and change PPPP to the password for the IP camera.

http://0.0.0.0/snapshot.cgi?user=yourusername&pwd=yourpassword
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Foscam Fi9802w
Sample URL:

1. Change the IP address to match your internal or external IP address.
2. Change UUUU to the username for the IP camera, and change PPPP to the password for the IP 

camera.
3. If you are using a different port than port 80, you will need to add that to the URL.

For example, some Foscam IP cameras use port 88, so 88 is added to the URL as follows:

Vivotek IP Cameras
IP cameras tested: 

• Vivotek FD8361

• Vivotek IP8352

For details on how to construct a URL for a Vivotek IP camera and configure security, see the 
documentation that came with the IP camera.

Example URL:

Here is an example of a URL to use with a Vivotek IP camera that is compatible with groov.

This IP camera is on port 8082, and it has been configured with a user viewer that has no username 
or password. Your IP camera may be configured differently.

Viewing a IP Camera Outside the Network
If you wish to view your IP camera image from outside your network, you have two options.

• Option 1: Ensure your IP camera can be accessed from out the local area network it is 
configured on. Please discuss this with your IT department to set up A VPN or allow a port 
forward on your router to the IP camera.

• Option 2: Use the Proxy option for the video gadget. In this case groov will poll the IP camera 
over your local area network and present the updated video frames to the client at the rate (in 
seconds) set on the video gadget.

CAUTION: Be aware that anyone with access to groov Build can view the username and password to 
the IP camera in clear text. This should be accounted for when setting up access to groov Build and access 
to the IP camera.

http://123.123.123.123/cgi-bin/CGIProxy.fcgi?cmd=snapPicture2&usr=UUUU&pwd=PPPP

http://123.123.123.123:88/cgi-bin/CGIProxy.fcgi?cmd=snapPicture2&usr=UUUU&pwd=PPPP

http://opto22.groov.com:8082/cgi-bin/viewer/video.jpg?channel=1&resolution=640x480&quality=3
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Changing the Video Gadget Refresh Period
The video gadget refresh period sets how often in seconds groov refreshes the image from an IP 
camera. You can set the default update period for all instances of the video gadget, or you can set 
the refresh period for an individual instance.

If you have a fast Internet connection and are not concerned about data use, then you can use the 
fastest setting (0.5 seconds) for a smoother video. However, if you have slower connection, the video 
might not be able to keep up, and you should back off the rate by entering a bigger value. Also, if 
you have a data use cap, you should probably back off the rate.

Satellite or cell modem networks may require refresh rates of 5 seconds or slower. For example, the 
default 0.5 seconds may be too fast for some ADSL connections.

To set the default update period for all video gadgets, do the following:

In Build, go to Configure > Project. In the General Settings window, enter a value for the “Default 
video gadget refresh period.” Click Save Settings, and then click Close.

To set the update period for an individual instance of the video gadget, do the following:

In Build, click the video gadget to display the Video Properties. Enter a value for the Update Period.

Enter the default 
refresh period

Update Period
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Appendix B

B: OPC UA Data Types 
Supported

The table below shows the official Browse Name for OPC UA data types and the corresponding 
names used in groov. The official OPC UA data type names are defined in the UA Specification (Part 5, 
Section 12). For information about the data types supported by a specific OPC UA server, see that 
company’s documentation.

OPC UA Type groov

Boolean Boolean

String String

SByte Signed Byte

Int16 16-bit Signed Integer

Int32 32-bit Signed Integer

Int64 64-bit Signed Integer

Byte Unsigned Byte

UInt16 16-bit Unsigned Integer

UInt32 32-bit Unsigned Integer

UInt64 64-bit Unsigned Integer

Float Single Float

Double Double Float

https://opcfoundation.org/developer-tools/specifications-unified-architecture/part-5-information-model
https://opcfoundation.org/developer-tools/specifications-unified-architecture/part-5-information-model
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Appendix C

C: Data Simulator Tags

The tags provided with groov’s built-in Data Simulator allow you to experiment with adding tags to 
gadgets, configuring the tags, and running your project in groov View. This appendix lists the Data 
Simulator tags and briefly describes what they do. The first section describes the Basic Tags. For 
Advanced Tags, see page 165.

Basic Tags
“Variables” (below)

“General” on page 162

“Square Waves” on page 164

“Sine Waves” on page 164

Variables
Unlike many other tags in the Data Simulator, you can read and write these basic variable tags. There 
are five each of boolean, float 32, integer 32, and string data types.

Variable Name Data Type 

bool Variable A boolean

bool Variable B boolean

bool Variable C boolean

bool Variable D boolean

bool Variable E boolean

float32 Variable A 32-bit float

float32 Variable B 32-bit float

float32 Variable C 32-bit float

float32 Variable D 32-bit float

float32 Variable E 32-bit float
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General
The complex and jagged waves have various ranges so that they don’t overlap too much when 
placed on the same Trend.

int32 Variable A 32-bit integer

int32 Variable B 32-bit integer

int32 Variable C 32-bit integer

int32 Variable D 32-bit integer

int32 Variable E 32-bit integer

string Variable A string

string Variable B string

string Variable C string

string Variable D string

string Variable E string

Variable Name Data Type Description

Complex Wave A 32-bit float A complex but smooth wave, composed of various sine 
waves, with values ranging from -6 to 6.

Complex Wave B 32-bit float A complex but smooth wave, composed of various sine 
waves, with values ranging from 2 to 14.

Complex Wave C 32-bit float A complex but smooth wave, composed of various sine 
waves, with values ranging from 0 to 40.

Complex Wave D 32-bit float A complex but smooth wave, composed of various sine 
waves, with values ranging from -10 to 10.

Jagged Wave A 32-bit float A jagged wave, composed of various sawtooth patterns, with 
values ranging from 0 to 15.

Jagged Wave B 32-bit float A jagged wave, composed of various sawtooth patterns, with 
values ranging from 5 to 25.

Jagged Wave C 32-bit float A jagged wave, composed of various sawtooth patterns, with 
values ranging from 10 to 40.

Ramp A (0 to 10, 30 sec) 32-bit float A ramp pattern, from 0 to 10, with a 30 second period.

Ramp B (0 to 10, 60 sec) 32-bit float A ramp pattern, from 0 to 10, with a 60 second period.

Sawtooth A (0 to 10, 30 sec) 32-bit float A sawtooth pattern, from 0 to 10, with a 30 second period.

Sawtooth B (0 to 10, 60 sec) 32-bit float A sawtooth pattern, from 0 to 10, with a 60 second period.

Stepper A (0 to 4, 30 sec) 32-bit integer Steps from values 0 to 4 over a period of 30 seconds.

Stepper B (0 to 9, 60 sec) 32-bit integer Steps from values 0 to 9 over a period of 60 seconds.

Stepper C (0 to 9, 90 sec) 32-bit integer Steps from values 0 to 9 over a period of 90 seconds. 

Variable Name Data Type 
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Sample Stepper, Sawtooth, and Ramp Waves

Sample Complex and Jagged Waves
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Square Waves

Sine Waves

Sample Sine Waves

Variable Name Data Type Description

Square Wave A (1 sec true/false) boolean A square wave with a period of 2 seconds: TRUE for 1 
second then FALSE for 1 second

Square Wave B (2 sec true/false) boolean A square wave with a period of 4 seconds: TRUE for 2 
seconds then FALSE for 2 seconds

Square Wave C (5 sec true/false) boolean A square wave with a period of 10 seconds: TRUE for 5 
seconds then FALSE for 5 seconds

Square Wave D (10 sec true/false) boolean A square wave with a period of 20 seconds: TRUE for 10 
seconds then FALSE for 10 seconds

Square Wave E (Random period) boolean A square wave with random TRUE/FALSE periods. Each 
TRUE and FALSE state will be within 2 and 4 seconds.

Square Wave F (Random period) boolean A square wave with random TRUE/FALSE periods. Each 
TRUE and FALSE state will be within 4 and 8 seconds.

Square Wave G (Random period) boolean A square wave with random TRUE/FALSE periods. Each 
TRUE and FALSE state will be within 6 and 12 seconds

Wave Name Data Type Description

Cosine (30 sec) 32-bit float Cosine wave with a 30 second period and amplitude of 1

Cosine (60 sec) 32-bit float Cosine wave with a 60 second period and amplitude of 1

Sine (15 min) 32-bit float Sine wave with a 15 minute period and amplitude of 1

Sine (30 min) 32-bit float Sine wave with a 30 minute period and amplitude of 1

Sine (30 sec) 32-bit float Sine wave with a 30 second period and amplitude of 1

Sine (5 min) 32-bit float Sine wave with a 5 minute period and amplitude of 1

Sine (60 sec) 32-bit float Sine wave with a 60 second period and amplitude of 1 
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Advanced Tags
“Variables (Extra)” (below)

“Arrays” on page 166

“User Controllable” on page 166

“Static Values” on page 167

Variables (Extra)
These variables have data types that are used less often. Unlike many other tags in the Data 
Simulator, you can read and write these variable tags. There are three of each type.

Variable Name Data Type 

float64 Variable A 64-bit float

float64 Variable B 64-bit float

float64 Variable C 64-bit float

int16 Variable A 16-bit integer

int16 Variable B 16-bit integer

int16 Variable C 16-bit integer

int64 Variable A 64-bit integer

int64 Variable B 64-bit integer

int64 Variable C 64-bit integer

int8 Variable A 8-bit integer

int8 Variable B 8-bit integer

int8 Variable C 8-bit integer

uint16 Variable A 16-bit unsigned integer

uint16 Variable B 16-bit unsigned integer

uint16 Variable C 16-bit unsigned integer

uint32 Variable A 32-bit unsigned integer

uint32 Variable B 32-bit unsigned integer

uint32 Variable C 32-bit unsigned integer

uint64 Variable A 64-bit unsigned integer

uint64 Variable B 64-bit unsigned integer

uint64 Variable C 64-bit unsigned integer

uint8 Variable A 8-bit unsigned integer

uint8 Variable B 8-bit unsigned integer

uint8 Variable C 8-bit unsigned integer
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Arrays
The arrays have the most common data types. Like the variables, you can read and write to the 
elements in the array tags.

User Controllable
There are two user-controllable waves (or patterns) that provide you something to interact with in 
the groov interface.

Ramp A: 0 to 10 is a ramping float32 value that you can start and then clear it back to 0.

Sine is a sine wave that you can control the period and amplitude. You can also disable the sine 
wave, during which time it has a value of 0.

Sample Ramp and Sine Waves

Array Name Data Type 

bool Array [100] boolean table

float32 Array [100] 32- bit float table

int32 Array [100] 32-bit integer table

string Array [100] string table

Wave Name Data Type Notes

Ramp A: 0 to 10 (Clear Flag) boolean A boolean flag to clear the ramp

Ramp A: 0 to 10 (Current Value) 32-bit float The current value of the ramp

Ramp A: 0 to 10 (Start Flag) boolean A boolean flag for starting the ramp

Sine (Amplitude, 1 to 1000) 32-bit float The amplitude of the sine wave (0 to 1000)

Sine (Enabled Flag) boolean The enable flag for the sine way (Setting this tag to False 
will disable the sine wave and set its current value to 0.)

Sine (Period, 1 to 1000 sec) 32-bit float The period of the sine wave (1 to 1000 seconds)

Sine (Value) 32-bit float The current value of the sine wave. 
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Static Values
These tags have static values, which means that they never change.

Static Value Name Data Type Notes

bool Always False boolean Always boolean “false“

bool Always True boolean Always boolean “true“

float32 Always +INF 32-bit float Always float32 “+INF”

float32 Always -INF 32-bit float Always float32 “-INF”

float32 Always 0.0 32-bit float Always float32 “0.0“

float32 Always 1.0 32-bit float Always float32 “1.0“

float32 Always NaN 32-bit float Always float32 “NaN”

float64 Always +INF 64-bit float Always float64 “+INF”

float64 Always -INF 64-bit float Always float64 “-INF”

float64 Always NaN 64-bit float Always float64 “NaN”

int32 Always 0 32-bit integer Always an int32 “0“

int32 Always 1 32-bit integer Always an int32 “1“

string Always ABC string Always a string of “ABC“

string Always Opto 22 string Always a string of “Opto 22“
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Index

A
above limit, 127
access

limiting users, 67, 70
logging out all users, 72
password, 66

adding
data simulator tags, 29
Data Store, 54
gadgets, 57
images, 73
Modbus tags, 35
OPC UA server, 43
PAC Control strategy, 30
page, 21
page category, 76
SNAP PAC controller, 30
system tags, 51
tags to gadgets, 57
user, 66

address
controller, Modbus device, or OPC-UA server,

changing, 56
admin security level, 67
aligning gadgets, 62
Android

app, 4, 134
API, 54
API key, 66

changing, 68
finding, 68
generating, 68

apps for mobile devices, 4, 134
automatic refresh of groov View, 134

B
backing up project, 83
below limit, 128
blank page, 145
browsers, 7

Button gadget, 97
button, normally open, 99
byte order, 34

C
camera, 93
category

adding, 76
deleting, 77
renaming, 78

changing
API key, 68
device address, 56
gadget properties in different layouts, 60
images, 76
user password, 71
users, 68
z order for Trend pens, 111

Checkbox gadget, 96
properties, 96

checking
groov version, 85

Chrome, 7
classic Trend gadget, 108
Command Button gadget, 98, 99

properties, 98
condition tags, 126
configuring

events, 116
gadget properties, 60
notifications, 121
pens for Trend gadget, 110

controller
adding, 30
deleting, 57

copying
gadgets, 61
page, 26

creating
events, 116
page, 21
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user, 66
CSS3, 7
CSV file, 42

downloading Trend pen data to, 111
exporting, 41
importing, 38

cutting gadgets, 61

D
data

downloading Trend pen data, 111
settings for Modbus, 34
types for OPC UA, 159
update frequency, 152
zoom in on Trend gadget, 109

data simulator, 29, 161
Data Store, 54
debounce time, 127
deleting

controller, 57
gadgets, 61
images, 76
Modbus/TCP device, 57
OPC UA server, 57
page, 25
page category, 77
users, 70

desktop layout, 63
disabling events, 119
disconnecting from groov on phone, 151
Divider gadget, 91

properties, 91
drag page, 27
duplicating a page, 26
dynamic tags, 46

E
editing

device address, 56
images, 76
pages, 153
security level, 67
users, 68

email
setting up, 121

email-to-SMS, 125
enabling events, 119
enlarging a page, 23
Enterprise option, 6
equal, 127
event conditions, 127

above limit, 127
below limit, 128

debounce time, 127
equal, 127
hysteresis, 127
inside range, 129
multiple conditions, 129
not equal, 127
outside range, 128

event message log capacity, 121
events, 119

creating, 116
enabling/disabling, 119
notifications, 121
receiving notifications, 123

expiration, license, 87
exporting

interface pages, 27
Modbus tags (CSV), 41

F
FactoryFloor, 154
finding API key, 68
Firefox, 7
firewall, 49

video gadget, 93
function codes, Modbus, 34

G
gadget

Button, 97
Checkbox, 96
Command Button, 98, 99
Divider, 91
Group Header, 90
Image, 94
Image Indicator, 105
LED, 95
Level Indicator, 101
Line Header, 91
Momentary Button, 99
Page Navigator, 92
Range Indicator, 107
Round Gauge, 106
Slider, 100
Text Area, 102
Text Box, 103
Trend, 108
Value, 104
Video, 93

gadgets
adding, 57
aligning, 62
changing z order, 61
copying, 61
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cutting and pasting, 61
locking into position, 61
moving, 59
moving to front or back, 61
multiples, 62
properties, 60
resizing, 59
sizing, 59, 62
stacking, 61
video, 155
video refresh, 81

general settings, 81
Gmail account, 122
graphics, 72
grayed out tags, 146
grid, showing or hiding, 23
groov API, 54
groov Box

locating on network, 148
passwords, 152

groov Build, 3, 11
opening in groov Server for Windows, 11
opening on a groov Box, 12

groov Find, 148
groov Server can’t open groov, 147
groov View, 3

changing password, 133
logging out, 132
navigation, 132
opening, 131
opening pages, 132
refreshing pages, 133
refreshing pages automatically, 134
switching to from groov Build, 82
using over the Internet, 143

groov View, mobile
Android, 4
iOS, 4, 134

groov, updating, 85
Group Header gadget, 90

properties, 90
groups of users, 70

H
handheld layout, 63
HDTV, 7
help, 145

Opto 22 Product Support, 8
Product Support, 8

hostname, 152
HTML5, 7
hysteresis, 127

I
Image gadget, 94

properties, 94
Image Indicator gadget

properties, 105
image library, 72
images

adding, 73
changing, 76
changing view in library, 74
deleting, 76
file types, 72
image library, 72
replacing, 76
uses, 72

importing
interface pages, 27
Modbus tags (CSV), 38

Indicator Button gadget
properties, 97

inside range, 129
interactive Trend gadget, 109
Internet Explorer, 7, 149
Internet, using groov, 143
iOS app, 134
IP address, 12
IP camera, 93, 155

refresh period, 81

K
KEPServerEX, 43
kiosk

automatic refresh, 134
do not expire login, 81
security level, 67

L
languages, Unicode support, 61
layout

optimizing, 63
types, 63

LED gadget
properties, 95

Level Indicator gadget, 101
properties, 101

license
expiration, 87
updating, 87

limiting
users, 67
users by groups, 70
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Line Header gadget, 91
properties, 91

locating groov Box on network, 148
locking gadgets, 61
Log Viewer, 79
logging events, capacity, 121
logging out

all users, 72
of groov View, 132

logo, adding, 72

M
maintenance

expiration date, 87
update, 87

managing
users, 65

message log capacity, 121
messages, viewing, 79
min/max values for Trend gadget, 111
mobile apps, 4, 134
mobile devices, 4, 134
Modbus, 34
Modbus/TCP

adding Modbus device, 32
adding Modbus tags manually, 35
cannot read/write data, 151
creating Modbus tags import file, 38
data, 151
data settings, 34
deleting device, 57
exporting Modbus tags import file, 41
function codes, 34
importing Modbus tags from CSV file, 42
protocol settings, 34
scaling data, 38
slave ID, 33
tag address, 37

Momentary Button gadget
properties, 99

moving
gadgets, 59
gadgets to front or back, 61
page, 27

multiple conditions, 129

N
Namespace Index, 48
navigation, 92, 98
not equal, 127
notifications, 123

configuring, 121
not being received, 146

O
OPC UA

browse name, 159
data types, 159

OPC UA server, 43
adding, 43
deleting, 57
Windows firewall, 49

opening
groov Build, 11
groov View, 131

operator security level, 67
Opto 22 controller, 30
Opto 22 Product Support, 8
OptoEMU Sensor, 153
organizing pages, 76
OS app, 4
outside range, 128

P
PAC Control

adding strategy, 30
updating tags, 32

Page Navigator gadget, 92
properties, 92

pages
adding, 21
categorizing, 76
deleting, 25
duplicating, 26
editing, 153
exporting, 27
hide grid, 23
importing, 27
navigating between, 92
opening in groov View, 132
organizing, 76
renaming, 26
show grid, 23
size, 23
stash, 24
won’t load, 145

password, 66, 152
changing, 71
changing in groov View, 133
IP camera, 156

pasting gadgets, 61
pens for Trend gadget, 110
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phone layout, 63
photos, 72
Plus option, 6
port forwarding, 143
Product Support, 8
project, 126

backing up, 83
exporting and importing pages, 27
restoring, 83
saving, 82
settings, 81

properties
Checkbox gadget, 96
Command Button gadget, 98
Divider gadget, 91
gadgets, 60
Group Header gadget, 90
Image gadget, 94
Image Indicator gadget, 105
Indicator Button gadget, 97
LED gadget, 95
Level Indicator gadget, 101
Line Header gadget, 91
Momentary Button gadget, 99
Page Navigator gadget, 92
Range Indicator gadget, 107
Round Gauge gadget, 106
Slider gadget, 100
Text Area gadget, 102
Text Box gadget, 103
Trend gadget, 108
Value gadget, 104
Video gadget, 93

properties, gadget
changing in different layouts, 60

protocol settings, Modbus, 34
proxy, 93

R
Range Indicator gadget, 107

properties, 107
receiving event notifications, 123
refresh period for Video gadget, 81, 158
refresh rate, video, 81, 158
refreshing groov View, 133

automatic refresh, 134
registers for Modbus, 34
release number, checking, 85
removing

page, 25
users, 70

renaming
page, 26

page category, 78
replacing images, 76
requirements, system, 6
resizing gadgets, 59, 62
restoring

to older groov version, 83
restoring groov project, 83
Round Gauge gadget, 106

properties, 106

S
Safari, 7
saving groov project, 82
scaling, 38
security level, 67, 152
setting up

events, 116
notifications, 121
users, 65

settings, video refresh period, 158
simulator, 29, 161
size, of page, 23
sizing

handles, 59
multiple gadgets, 62

slave ID, 33
Slider gadget, 100

properties, 100
smartphone layout, 63
SMTP server, 123
SNAP PAC controller, 30
SoftPAC, 31
Solo option, 6
stacking gadgets, 61
STARTTLS, 123
stash, 24
static IP address, 12
static tags, 45
strategy

.idb.txt file, 153
adding, 31
updating tags, 32

SVG, 7
system

adding system tags, 51
requirements, 6

T
tablet layout, 63
tag address, 37
tag simulator, 29
tags, 126
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adding data simulator, 29
adding Data Store, 54
adding gadgets, 57
adding Modbus/TCP device, 32
adding OPC UA server, 43
adding Opto 22 controller, 30
adding System, 51
dynamic, 46
grayed out, 146
in data simulator, 161
Modbus/TCP, 42
static, 45
updating PAC Control strategy, 32
viewing, 78

Technical Support. See Opto 22 Product Support, 8
test email, 123
Text Area gadget, 102

properties, 102
Text Box gadget, 103

properties, 103
text message notifications, 124, 125
text messaging, setting up, 121
text, Unicode support, 61
time stamp, 126
Trend gadget, 108

changing pen z order, 111
classic trend, 108
configuring pens, 110
downloading pen data, 111
interactive trend, 109
min/max values, 111
properties, 108

troubleshooting, 145
blank page, 145
can’t open groov (groov Server), 147
cannot read/write Modbus data, 151
disconnecting from groov on phone, 151
grayed out tags, 146
Internet Explorer, 149
Log Viewer, 79
notifications not received, 146
Opto 22 Product Support, 8
pages won’t load, 145
yellow triangle, 146

U
Unicode support, 61
updating

data, frequency, 152
groov software, 85
license, 87
PAC Control strategy tags, 32
users, 68

User Account Control, 148
username, 66

for IP camera, 156
users

adding, 66
changing, 68
changing password, 71
creating, 66
deleting, 70
groups, 70
kiosk login, 81, 134
limiting access, 70
logging out all users, 72
password, 152
security level, 67, 152
types, 65

V
Value gadget, 104

properties, 104
verify tags, 45
version, checking, 85
version, restoring to older groov version, 83
Video gadget, 93

properties, 93
refresh period, 81
setting up camera, 155
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